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1 What’s New in REAKTOR 5.9.2

 

Welcome to REAKTOR 5.9.2! This manual addendum provides information about the new fea-
ture in this release: Dynamic Automation Labels.

1.1 Dynamic Automation Labels
 

The Automation Module (see ↑2.1.2, Automation Module for more information) can now
change its parameter label/name that is sent to the host during runtime, utilizing its new input
port:

Sel (Select) - Events arriving at this input select one of the available list entries. This means
the host gets a notification that the parameter name has changed on runtime.

The new Sel input port of the Automation module.

What’s New in REAKTOR 5.9.2
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1.1.1 Adding and Deleting Parameter Name Entries
 

To define the parameter name entries:

1. Select the Automation Module and open its properties.
2. Click on the CONNECT tab.
3. In the Custom Parameter Names table, click the Add button to add an entry, or the Delete

button to delete an entry from the list.

1.1.2 Editing Parameter Name Entries
 

Each entry has an index (#) and a value (Value) field:

▪ The index is automatically set as an integer, starting from 0 for the first entry.

▪ The value is the automation parameter label that is to be sent to the host.

To change a value :

► Double-click on the text you wish to edit. Type the text you wish to be associated with the
corresponding index.

The Sel input selects which entry from the list is used as the automation parameter label:

▪ If the Sel input is not connected, then entry 0 is used.

▪ If the list is empty, then the original default parameter label will be used (i.e. the mod-
ule’s name and its macro path).

▪ If the Sel input is out of bounds, then it is clipped to 0 → n-1, where n is number of
items in the list.

1.1.3 Bulk List Actions
 

You can create and edit lists of automation parameter labels outside of REAKTOR, which will
considerably speed up the process of creating and saving large lists. To open, save, or clear
lists of automation parameter labels, use the Custom Parameter Names table’s additional but-
tons.

What’s New in REAKTOR 5.9.2
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Use the buttons highlighted above to open and save long lists of automation parameter labels.

(1) Read from File: Click this button to open a file selection dialog that allows you to select a
plain text file. The list of automation parameter labels will be filled with the content of this
file.

This action will replace any existing list content.

(2) Save to File: Click this button to open a file save dialog that allows you to save the current
list of automation parameter labels as plain text file.

(3) Clear List: Click this button to clear the entire list of automation parameter labels.

The file format is plain ASCII text with one line per entry. An entry index number is not
needed, as REAKTOR will create these numbers.
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Dynamic Automation Labels

 

REAKTOR 5 - Manual Addendum - 10



2 What's New in REAKTOR 5.9.1

 

Welcome to REAKTOR 5.9.1! This manual addendum provides information about new fea-
tures, usability updates and improvements. Here is a brief overview of the most important
changes and additions:

▪ ↑2.1, Custom Automation Names and New Automation Module

▪ ↑2.2, Hardware Control Module

▪ ↑2.2.2, Available Note Colors

▪ ↑2.4, Voice Info - Unison Min/Max Inputs

▪ VST Support for 16 outputs

2.1 Custom Automation Names and New Automation Module
 

REAKTOR 5.9.1 introduces two new features that provide enhanced options for customizing
automation strings:

▪ Custom Automation Names

▪ Automation Module

2.1.1 Custom Automation Names
 

Every control that sends automation data now has a new entry field into which you can enter a
custom parameter name that is sent to the host.

A control's automation name was previously linked directly to the module name and the mac-
ro(s) it occupied. This behavior still remains by default, but can be overwritten in the following
manner:

1. Select the control you wish to edit and open its properties
2. Click on the CONNECT tab. The AUTOMATION section is located at the bottom of this tab

What's New in REAKTOR 5.9.1
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3. Enter the name you wish to use for the control in the Custom Parameter Name text box.

Deleting the contents of this text box will return the control automation name to the origi-
nal default name.

2.1.2 Automation Module
 

Sending and receiving automation data was always possible with the simple panel elements
(like knobs and XY panels), but it was not possible to send data generated by other elements,
like the Mouse Area module.

The Automation module allows you to send and receive data to and from a host without the
need of a standard control.

The module also allows you to send custom lists as well as numeric values, allowing for more
user-friendly automation displays.

► The Automation module is located in the Auxiliary section of the Built-in Module list.

The Automation Module

The inputs of the module are as follows:

▪ Tch (Touch) - sends the touch-state of the parameter, in other words: this lets the host
know whether or not the user is moving the connected control.

◦ A value greater than 0 should be sent if the touch-state is active.

◦ A value of 0 or less should be sent if the touch-state is inactive.

What's New in REAKTOR 5.9.1
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▪ Val (Value) - sets the current value of the module to be sent when an event arrives at the
Trig input.

▪ Trig (Trigger) - an event at this input triggers a send of the value currently at the Val in-
put. To send, the Tch input also needs to be set to active state. If Tch input is in inactive
state, then this Trig input has no effect.

The module has a single output:

▪ Val - outputs the automation value received from the host.

List Mode

In the module properties it is possible to select between Value and List modes of operation.

► The MODE setting is located in the FUNCTION tab of the module properties.

When List is selected, the module sends strings from a list, rather than the value at the Val
input. The Val input is now used to select entries from the list.

The contents of the list can be set in the LIST ENTRIES section of the module properties.

What's New in REAKTOR 5.9.1
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The Default List Entries

Here you can Add and Delete entries in a manner similar to the List module.

Each entry has an index (#) and a Value:

▪ The index is automatically set as an integer, starting from 0 for the first entry.

▪ The value is the text that is to be sent to the host.

To change a Value:

1. Double-click on the text you wish to edit.
2. Type the text you wish to be associated with the corresponding index.

2.2 Hardware Control Module 
 

The Hardware Control module allows greater integration with NATIVE INSTRUMENTS hardware
products. The module is designed to be updated with any new hardware NATIVE INSTRU-
MENTS might release in the future.

At the time of writing, this module allows custom control over certain features of the KOM-
PLETE KONTROL S-SERIES hardware.

What's New in REAKTOR 5.9.1
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► The Hardware Control module is located in the Terminal section of the Built-in Module
list.

The Hardware Control Module

The Hardware Control module has four inputs:

▪ Msg (Message Type) - selects the message type to be sent by the module.

▪ Idx (Index) - sets the index of the array into which data is to be written.

▪ W (Write) - writes a value into the currently selected array index.

▪ Trig (Trigger) - triggers the contents of the module's array.

REAKTOR must be used as a plug-in in the MASCHINE or KOMPLETE KONTROL software
in order for the Hardware Control messages to be sent. Hardware Control messages are not
sent when REAKTOR is used in stand-alone mode.

2.2.1 Message Types
 

Message Type Msg Input Value

Set single note attributes 10

Set 128 note colors 11

Set note pressed support 40

Set Single Note Attributes

For this message type, the first index of the array (index 0) sets the MIDI note number, and the
following indices are used to set various attributes for that note:

What's New in REAKTOR 5.9.1
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Array[0] Array[1] Array[2] Array[3]

MIDI Note Number Note Color Pressed State (0 or 1) Note Type (0 or 1)

0 … 127 0 … 17 0: Unpressed

1: Pressed

0: Default

1: Control

The Note Type tells KOMPLETE KONTROL whether this is a standard playable note, or wheth-
er it's a control note used for special functions in instruments. Control notes will be excluded
from performance functions, like the arpeggiator, in KOMPLETE KONTROL.

Sending any value outside of the value ranges specified above will cause the message to be
ignored, and the relative setting will remain unchanged.

The pressed state will only be sent if Note Pressed Support is set to be active.

Set 128 Note Colors

This message type allows you to send the note colors for all MIDI notes in a single array. With
this message type, the array index represents the MIDI note, and the value of that index sets
the note color.

Array[0] Array[1] … Array[126] Array[127]

MIDI Note 0 Color
(0…17)

MIDI Note 1 Color
(0 … 17)

… MIDI Note 126 Col-
or (0 … 17)

MIDI Note 127 Col-
or (0 … 17)

Set Note Pressed Support

A value of 40 at the Msg input sets the module to send the Note Pressed Support state. A sin-
gle yes/no (0/1) value is needed, and is sent in array index 0:

▪ 0: No - REAKTOR will not send Note Pressed messages; this is to be handled by the host.

▪ 1: Yes - REAKTOR will send Note Pressed messages, taking control of this from the host.

What's New in REAKTOR 5.9.1
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2.2.2 Available Note Colors
 

Value Color

0 Red

1 Orange

2 Light Orange

3 Warm Yellow

4 Yellow

5 Lime

6 Green

7 Mint

8 Cyan

9 Turquoise

10 Blue

11 Plum

12 Violet

13 Purple

14 Magenta

15 Fuchsia

16 Default

17 Inactive

If you send a note color value outside of the 0 to 17 range, the message will be ignored
and the previous note color will not change.

2.3 Mouse Area - Mouse Over Output
 

The Mouse Area module has been updated to include a new output: MO (Mouse Over).

What's New in REAKTOR 5.9.1
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The Mouse Area Module

This output allows you to sense whether or not the mouse cursor is hovering over the Mouse
Area on the panel.

▪ An event is sent each time the state changes.

▪ The event has a value of 1 when the mouse cursor is in the Mouse Area.

▪ The event has a value of 0 when the mouse cursor is not in the Mouse Area.

You can access the mouse position when the mouse cursor is hovering of the Mouse Area
by using the PX and PY outputs, and checking the Always send PX and PY events option in
the Mouse Area properties.

2.4 Voice Info - Unison Min/Max Inputs
 

The Voice Info module has been updated to include two inputs:

▪ Min - sets the minimum unison voices for the instrument.

▪ Max - sets the maximum unison voices for the instrument.

The Voice Info Module

These inputs mimic, and are connected to, the Unison options in the instrument properties.

What's New in REAKTOR 5.9.1
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If nothing is connected to these inputs, the settings in the instrument properties will be used,
otherwise, the values at these inputs will be used.

What's New in REAKTOR 5.9.1
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3 What's New in REAKTOR 5.9

 

Welcome to REAKTOR 5.9! This manual addendum provides information about new features,
usability updates and improvements. Here is a brief overview of the most important changes
and additions:

▪ ↑3.1, Panelset Updates

▪ ↑3.2, Double-click Control Behavior

▪ ↑3.3, QuickBus Highlighting in Core Structures

▪ ↑3.4, Dedicated Sample Map Menu in the Sample Map Editor

▪ ↑3.5, Snapshot Updates

▪ ↑3.6, MASCHINE 2 Integration

3.1 Panelset Updates
 

REAKTOR 5.9 features two improvements to the Panelsets:

▪ Panelsets can now be accessed when in Play Mode.

▪ The header visibility state of an instrument/ensemble is saved in the Panelset.

Panelsets are also part of the improved MASCHINE integration.

3.2 Double-click Control Behavior
 

Double-click behavior has been refined to have two different functions depending on whether
or not Edit Mode is active:

▪ When in Edit Mode: double-clicking on a control will open the control's properties.

▪ When in Play Mode: double-clicking on a control will set that control to the default value.

What's New in REAKTOR 5.9
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3.3 QuickBus Highlighting in Core Structures
 

To make it easier to navigate and edit Core structures, QuickBus highlighting has been added.

When you select any QuickBus connection, all connections to that same QuickBus will be un-
derlined.

QuickBus highlighting of the Sens variable in a core structure using many QuickBuses.

When you click on any module or macro with QuickBus connections, all connections to the rel-
evant QuickBuses will be highlighted in the same manner.

What's New in REAKTOR 5.9
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The same structure as before, but with one of the AHD macros selected.

3.4 Dedicated Sample Map Menu in the Sample Map Editor
 

To make using Sample Maps in REAKTOR more intuitive, the Sample Map import and export
commands have been moved to a dedicated Sample Map menu.

The menu is located above the Sample Map list.

The Sample Map Menu

What's New in REAKTOR 5.9
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The Sample Map menu contains the following commands:

▪ Import (Merge) …: opens a dialog window to load a Sample Map file and merge it with
the currently loaded Sample Map.

▪ Import (Replace) …: opens a dialog window to load a Sample Map file to replace the cur-
rently loaded Sample Map.

▪ Export including Audio Data …: opens a dialog window to save the current Sample Map
with all the relevant audio data embedded in the file.

▪ Export with References Only …: opens a dialog window to save the current Sample Map
without any embedded audio, but with references to files on your hard drive.

3.5 Snapshot Updates
 

3.5.1 Snapshot Tagging
 

As part of the improved MASCHINE integration, the snapshot interface and features have been
updated. For more information on Snapshot tagging, please refer to section ↑3.6, MASCHINE
2 Integration.

3.5.2 Default if Missing Option
 

Any modules that store data in a Snapshot (for example: knobs, lists, snap value, etc.) now
have a new option in the SNAPSHOT section of the FUNCTION properties: Default if Missing.

What's New in REAKTOR 5.9
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The Default if Missing checkbox

If you have created an ensemble and saved a number of Snapshots, then added extra controls
to the ensemble after these Snapshots were generated, this control specifies how this module
will react to Snapshot recall.

▪ When checked: if the loaded Snapshot does not contain specific information for the mod-
ule, and the Snap Isolate property is unchecked, it will reset to the default value as speci-
fied in its properties.

▪ When unchecked: if the loaded Snapshot does not contain specific information for the
module, it will remain at the last specified value (ie, a Snapshot recall will not change the
value of the module).

▪ If the loaded Snapshot does contain data for the module, it will set the value of the module
as expected.

▪ The behavior is slightly different when used in a host:

▪ When checked: loading a host project with no value for the control will cause it to reset to
default, regardless of the Snap Isolate setting.

▪ In all other cases, the behavior is the same.

What's New in REAKTOR 5.9
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Any ensembles created before REAKTOR 5.9 will have the Default if Missing option un-
checked for all relevant modules.

3.6 MASCHINE 2 Integration
 

The following chapter will cover the new features that relate to integrating your REAKTOR en-
sembles into MASCHINE 2's browser.

3.6.1 Snapshot Visibility
 

When using REAKTOR, you can browse for a number of different things: ensembles, modules,
Snapshots, etc. Generally a Snapshot is considered to be a REAKTOR sound preset.

Since the MASCHINE Browser is used primarily to navigate sounds, it has been designed to
scan for Snapshots within a REAKTOR Ensemble file. However, Snapshots need to be tagged
in a way so that MASCHINE can integrate them in a sensible way.

Tagging Snapshots

Since a REAKTOR ensemble can be an instrument, an effect, or even both, we need to com-
municate which of these the Snapshot is classed as so MASCHINE will know where to place it
in the Browser.

Tagging is done in the Snapshot window.

What's New in REAKTOR 5.9
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► To display Snapshot tags, enter the Edit menu and select Show Meta Info.

→ A new column will appear in the Snapshot browser displaying any tags applied to the
Snapshots and Banks.

There are four kinds of tags:

▪ None: the sound will be hidden from the MASCHINE browser.

▪ Inst: an Instrument sound. Any Snapshot that generates audio, but does not alter incom-
ing audio should be tagged as an Instrument sound.

▪ FX: an Effect sound. Any Snapshot that relies on, alters, or reacts to incoming audio
should be tagged as an Effect sound.

▪ Both: a sound that can be either an Instrument or Effect. Any Snapshot that generates
audio independently, but can also react to incoming audio somehow, should be tagged as
Both.

Tagging a Single Snapshot

1. Right-click on the Snapshot in the Snapshot browser.
2. Navigate to NI Meta Info to display the available tags.

What's New in REAKTOR 5.9
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3. Select the relevant tag for the Snapshot.

Tagging a Snapshot Bank

Tagging a Snapshot bank will tag all Snapshots contained in that Bank with the same setting.

1. Right-click on the Bank name in the browser.
2. Navigate to NI Meta Info to display the available tags.
3. Select the relevant tag for the Snapshot.

After tagging, be sure to save the Ensemble file to make the changes permanent.

Single Preset Files

If you save a preset file in REAKTOR - by using the Save Preset As… command in the File
menu - the saved file will take the tag information from the last selected Snapshot.

If the Snapshot had no tag, you can tag it by using the Snapshot menu in REAKTOR's toolbar:

1. Right-click on the Snapshot menu.

What's New in REAKTOR 5.9
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2. Select the tag you wish to use.

3. Re-save the preset file.

Tagging a preset using this method will not change the tag of the original Snapshot.

3.6.2 Defining the Sub-Bank Name
 

Any ensemble created in REAKTOR and tagged to be found in MASCHINE 2's Browser will be
automatically located in the REAKTOR bank.

In order to make locating the sounds easier, you can define a Sub-Bank name.

The Sub-Bank name is automatically taken from the name of the ensemble's Snapshot Master.

Changing the Snapshot Master

By default, the Snapshot Master is the ensemble itself. However it is possible to change it to
any instrument in the ensemble.

To change the Snapshot Master:

1. Select the instrument you wish to be the new Snapshot Master.
2. Enter the instrument's properties and navigate to the FUNCTION tab.
3. Toward the end of the function properties, there is a section labeled SNAPSHOT.
4. In this section, activate the Set As Master button.

→ The selected instrument is now the Snapshot Master for the ensemble.

What's New in REAKTOR 5.9
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3.6.3 Panelsets
 

Even if no action is taken, your REAKTOR ensemble's interface will appear in the MA-
SCHINE 2 interface when a sound from it is loaded. The appearance will be the same as the
last saved state.

However, it is possible to make some optimizations to make using your ensemble in MA-
SCHINE 2 a better experience.

Default and Additional Views

MASCHINE 2 has two ways of viewing a REAKTOR ensemble's interface:

▪ Default View

▪ Additional View

These views are taken automatically from the ensemble's Panelsets.

In order for MASCHINE 2 to recognize a Default and Additional view, you need to create two
Panelsets:

▪ The first Panelset will be the first view displayed - the Default View.

▪ The second Panelset will be the alternate view - the Additional View.

Any further Panelsets will not be recognized by MASCHINE, though they will not interfere with
the MASCHINE integration.

What's New in REAKTOR 5.9
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4 What’s New in REAKTOR 5.8?

 

Welcome to REAKTOR 5.8! This manual addendum provides information about new features,
usability updates and improvements. Here is a brief overview of the most important changes
and additions:

▪ ↑4.1, OSC Settings

▪ ↑4.2, OSC and MIDI Controller Handling

▪ ↑4.3, New OSC Array Modules

▪ ↑4.4, Other OSC Improvements

▪ ↑4.5, Sample Management

▪ ↑4.6, Updates to Mouse Controlled Elements

▪ ↑4.7, Bookmark Behavior for Screensets

▪ ↑4.8, Updated Screenset Options

4.1 OSC Settings
 

The OSC Settings window has been updated for better clarity and ease of use.

► To open the OSC Settings window, enter the File menu and select OSC Settings…

What’s New in REAKTOR 5.8?
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OSC Settings window (OSC Receive tab)

If you have used the OSC Settings before, you will have noticed that the OSC Settings window
now uses tabs to navigate between the different sections:

▪ OSC Receive: Set up communication from an OSC Device to REAKTOR here.

▪ OSC Send: Set up communication from REAKTOR to other OSC Devices here.

▪ OSC Sync: Contains the OSC sync options.

► In order to use OSC in REAKTOR, check the global OSC Activate check box in the top left
corner of the OSC Settings window.
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OSC Receive

OSC Receive Main Settings

The OSC Receive tab contains three main areas:

To the top left is the Receive on Port value display. This is where you can view or edit REAK-
TOR’s OSC input Port number.

► To change the Port number, double-click on the value displayed, and enter a new value.

The Port number is important for use in setting up communication from your OSC device.

To the top right you will see a display of the Local IP Addresses currently accessed by REAK-
TOR. These addresses are not editable from REAKTOR, but are displayed for use in setting up
your OSC device.

The large area at the bottom of the window is the Incoming OSC Monitor.

OSC Monitor

This displays all of the incoming OSC messages received by REAKTOR, and is primarily used
for checking your connection is working correctly.

What’s New in REAKTOR 5.8?

OSC Settings

 

REAKTOR 5 - Manual Addendum - 32



► To clear the monitor contents, click on the Clear button to the top right of the monitor
display.

OSC Send

OSC Send Settings

This area is used for entering the information of your OSC device(s) to enable communication
from REAKTOR to the device(s).

To enter the OSC target’s information:

1. First, click on the New button below the OSC Targets window. A new target will then ap-
pear in the window with default information.

2. Enter the relevant information into the fields by clicking on the field and typing the cor-
rect settings from your OSC device.
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3. When all the information is all entered correctly, if your OSC device has an incoming OSC
indicator, you can send a test message by clicking the Test button. The test message will
be sent out to all of the OSC targets in the list.

To automatically search for other OSC enabled instances of REAKTOR:

1. Click the Scan button. REAKTOR will send a 'ping' message and listen for a 'pong.'
2. A list of devices that sent a 'pong' reply to REAKTOR will appear in the OSC Targets list.

Remove any targets that you do not wish to use by clicking on the target name in the list
to select it, then click the Remove button to remove them.

Note that Scan only scans between port ranges 10000 and 10015.
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OSC Sync

OSC Sync Settings

The OSC Sync tab contains three main options for how REAKTOR should use OSC Sync mes-
sages:

▪ No Sync: REAKTOR will not send, nor will it respond to, OSC Sync messages.

▪ Enable Sync as Master: REAKTOR will send OSC Sync messages to any device connected
in the OSC Send tab.

▪ Enable Sync as Slave: REAKTOR will slave to OSC Sync messages sent from any device
connected in the OSC Receive tab.

If either of the last two options is selected, two more options will be visible in the Select Sync
Type: box.
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OSC Sync Type Options

These options allow you to select the type of OSC Sync messages to be used:

▪ Time Sync: sends/receives transport messages (start/stop/continue) as well as tempo infor-
mation.

▪ Clock Sync: sends/receives transport messages only.

4.2 OSC and MIDI Controller Handling
 

REAKTOR 5.8 introduces a new CONTROLLERS tab to the side pane, from which you can
easily manage, edit and assign connections from both MIDI and OSC devices. The CONTROL-
LERS tab is also available in Play Mode, allowing you to assign MIDI and OSC connections
without editing the ensemble structure.

When using REAKTOR as a plug-in, the controller assignments made in the CONTROL-
LERS tab are saved along with the host project.

The CONNECT tab for panel elements has also been updated for improved usability. For de-
tails see ↑4.2.2, Updated Connect Tab.

4.2.1 Controller Mapping
 

The CONTROLLERS tab shares the PANELSETS tab of the side pane.
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The Controller Mapping Pane

► In Edit Mode, use the CONTROLS and PANELSETS sub-tabs to switch between the Con-
troller Mapping and the Panelsets panes.

In Play Mode, the Panelsets are not accessible from this tab, and so the sub-tabs will not
be visible.
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At the top of the Controller Mapping pane are two tabs, one for viewing and managing MIDI
connections, and the other for viewing and managing OSC connections. These tabs are labeled
MIDI and OSC respectively.

► To view the list of relevant current connections and recently used messages, click on ei-
ther tab. Connections and messages will be displayed:

▪ The current connections appear at the top of the list (they will be identifiable by the infor-
mation present in the Target column).

▪ Recently received messages appear below the current connections (by default, this list
will only be refreshed each time you open the tab).

▪ For MIDI, controller messages will appear above note messages.

► To view incoming messages in real-time, activate the Auto button below the list. Not only
will this re-populate the list in real-time, but it will also highlight currently used messag-
es.

OSC Messages are highlighted as they are received.

Filtering the List by Controller Data Type

► To filter the list of controller messages by data type, right-click (Mac OS X: [CTRL] +
click) the Control column's header and select the data type from the context menu:
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▪ All: Select this entry to see all MIDI message types.

▪ CC: Select this entry to see only MIDI CC (Continuous Controller) data.

▪ Note: Select this entry to see only MIDI Note data.

▪ AT: Select this entry to see only MIDI Aftertouch data.

The Control (Controller Data) context menu of the Controller Mapping pane

Filtering the Controller List by MIDI Channel

► To filter the list of controller messages by MIDI channel, right-click (Mac OS X: [CTRL] +
click) the Ch (Channel) column's header and select the MIDI channel from the context
menu.
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The Ch (Channel) context menu of the Controller Mapping pane

Filtering the Controller List by Ensemble or Instrument

► To filter the list of controller messages by Ensemble or Instrument, right-click (Mac OS X:
[CTRL] + click) the Target column's header and select the ensemble or instrument from
the context menu.

The context menu will be populated depending on the currently loaded Ensemble or Instru-
ment.
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The Target context menu of the Controller Mapping pane

Clearing Unmapped Controller Data from the Controller List

► To clear unmapped data from the controller list, click on the Clear List Button, located at
the bottom of the Controller Mapping pane.

The Clear List button in the Controller Mapping pane

Assigning and Deleting Controller Assignments

► To assign MIDI and OSC controllers from this pane, drag the controller's entry from the
list to the control you wish to connect to within REAKTOR.
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Dragging a controller's list entry to an Instrument's control

To delete an assignment you can either:

► Select the relevant controller from the list and press the Delete key on your computer
keyboard, or

► Select the controller from the list and click on the Remove Assignment button (garbage
can icon) below the list.

The Remove Assignment button (garbage can icon)

Assigning Controllers through MIDI/OSC Learn

To the top right of the Controller Mapping pane, you will find the re-located MIDI Learn button,
which now also functions as an OSC Learn button. This allows you to use MIDI/OSC Learn in
Play Mode.

To connect a MIDI/OSC controller to a REAKTOR control using the MIDI/OSC Learn button:

1. Click on the MIDI/OSC Learn button to activate MIDI/OSC Learn mode.
2. Click on the control you wish to connect to in the REAKTOR interface.
3. Move the controller on your MIDI or OSC device that you wish to connect to the control in

REAKTOR

→ The connection should now be made and will be visible in the Controller Mapping list.
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4.2.2 Updated Connect Tab
 

The MIDI and OSC connection settings within the module properties have been updated to be
easier to use and more clearly laid out.

► To access the MIDI and OSC connection settings, click on the CONNECT tab in a con-
trol’s properties.

In the MIDI and OSC Connections area you will see three tabs:

▪ MIDI: This is where you can access the controls to set up a MIDI control and/or MIDI out-
put for a control. The properties of this area remain as they were in previous REAKTOR
versions.

▪ OSC RCV (OSC Receive): In this tab you will find the options for connecting an OSC
source to control the REAKTOR module.

▪ OSC SEND: This tab contains the settings for sending OSC messages from the module to
another OSC device.

In order for the OSC settings to function correctly, you must first set up the OSC properties
in the OSC Settings window.
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OSC Receive

OSC Receive Connection Settings

The main area of the OSC RCV (OSC Receive) tab displays a list of currently connected OSC
sources and, where applicable, the parameter index number.

To add a new OSC source to the list:

1. Click on the Add Source drop-down menu.
2. Select the New… entry, and then type the name of the OSC Address.

→ The newly created OSC source will be added to the list of controllers.

To add an OSC source from a list of recently received OSC controllers:

1. Click on the Add Source drop-down menu.
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2. Select the Recently Received entry, and then select one of the options available.

→ The selected OSC source will be added to the list of controllers.

You can clear the Recently Received list by using the Clear Recent List option in the Add
Source menu.

To delete an Address Pattern, select the Address you wish to delete in the list and either

► press the Delete key on your computer keyboard, or

► click on the Delete Source button (garbage can icon) to the right of the list.
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OSC Send

OSC Send Connection Settings

The OSC SEND tab’s main area is a list of currently connected Targets (OSC devices).

To define the OSC Target to which the OSC message will be sent:

► The Add Target drop-down menu below the list will be populated with Identifiers set up
in the OSC Settings. Select the OSC Identifier's entry from the Add Target drop-down
menu.

The Address Pattern of the OSC message sent from the control can be entered manually in
the Send Address Pattern field. By default, the Send Address Pattern is based on the name
of the control.

4.3 New OSC Array Modules
 

REAKTOR 5.8 adds two new built-in modules: OSC Receive Array and OSC Send Array. Both of
these modules can be found in the Terminal category, along with the other OSC modules.
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4.3.1 OSC Receive Array
 

The OSC Receive Array Module

The OSC Receive Array module (OSC Rcv Array) is designed to be used with any OSC message
that is sent in an array format, using indices. A maximum of 128 array elements is supported.

In order for the OSC Receive Array module to work correctly, you need to add an OSC
source in the CONNECT tab using the method covered in section ↑4.2.2, Updated Connect
Tab.

When a message is received by this module, the following values are sent from the 4 ports:

▪ The N port sends the number of received elements.

▪ The Gate port sends a value of 1.0.

▪ For each element the Idx port sends the index number (0 to N-1), and the Out port sends
the value of the array element at [Idx].

▪ Finally, when all of the data is sent from the Idx and Out ports, the Gate output sends a
value of 0.

4.3.2 OSC Send Array
 

The OSC Send Array Module
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The OSC Send Array module sends OSC messages using an indexed array of parameters. A max-
imum of 128 array elements is supported.

In order for the OSC Receive Array module to work correctly, you need to add an OSC target
in the CONNECT tab using the method covered in section ↑4.2.2, Updated Connect Tab.

▪ Parameter values are written into the array using the Idx and W inputs.

▪ The N input determines how many parameters will be sent. If the N input is not connect-
ed, or is set to zero, all of the parameters in the array will be sent.

▪ The message is sent when an event is received at the Trig input.

4.4 Other OSC Improvements
 

REAKTOR 5.8 also includes the following OSC improvements:

▪ OSC is now enabled when REAKTOR is used as a plug-in.

▪ The MIDI activity meters have been updated to also display OSC activity.

▪ Limits on the total number of OSC connections have been removed.

▪ The maximum number of ports for the OSC Send and OSC Receive modules has been in-
creased to 40.

4.5 Sample Management
 

REAKTOR 5.8 includes two major updates to sample management:

▪ Samples and Sample Maps can now be edited in Play Mode.

▪ The embedding of samples in the ensemble is now a property of the sample itself.

Moved Controls

These updates include many smaller updates, including usability changes:
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▪ The preferences of the Sample Map Editor itself, i.e. the editing and pre-listen preferences,
are now in the far right-hand corner settings menu.

▪ The Prelisten button (loudspeaker icon) is now in the Sample Info bar above the Sample
Map/Waveform display.

4.5.1 The Sample Map Editor
 

One of the first changes you may notice is that now, because the Sample Map Editor is availa-
ble in Play Mode, the button used to access it has moved to the main tool bar at the top of the
interface, beside the Player/Recorder and the Info Hints buttons.

The new location of the Sample Map Editor button.

To open the Sample Map Editor either:

► Click on the Sample Map Editor button mentioned above, or

► Press [F9] on your computer keyboard.
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The Sample Map Editor

The Sample Map Editor is divided into two halves:

▪ The left half is dedicated to a Sample List View.

▪ The right half can switch between the Keymapping View and the Sample Waveform View.

4.5.2 Sample List View
 

In Edit Mode, the Sample List View gives you an overview of the samples currently used in the
selected Sample Map, as well as options to edit the Sample Map. The Sample List itself dis-
plays basic information for all of the samples in the Sample Map: Name, Root note, Low note
(L), High note (H), Low velocity (LVel), High velocity (HVel), Embed status, and Location.
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Sample List View (Edit Mode)

In Play Mode, only the Name and Location columns are visible in the Sample List View.

Sample List View (Play Mode)

Above the Sample List is a drop-down menu (by default labeled Sample) that allows you to
navigate between the different sample modules available in the currently loaded ensemble.

What’s New in REAKTOR 5.8?

Sample Management

 

REAKTOR 5 - Manual Addendum - 51



► To open the relevant Sample Map in the Sample Map editor, select an entry from the drop-
down menu.

The drop-down menu containing sample modules

The Show Sample Module in Structure button to the right of the Sample menu provides imme-
diate access to the sample module in the Structure:

► To display the currently selected sample module in the structure of the ensemble, click the
Show Sample Module in Structure button.

The Show Sampler Module in Structure button

The Show Sampler Module in Structure button is only available in Edit Mode.

Sample Embed Status

The Embed status of a sample can be changed by clicking on the sample's check box.

The Sample Embed Status

▪ If the box is checked, the sample will be embedded in the ensemble file when it is saved.
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▪ If the box is not checked, the sample will be referenced from its location on your comput-
er’s hard drive.

If a number of samples are selected when you check or uncheck the Embed checkbox, all
samples will be affected in the same manner.

Un-checking the Embed checkbox of a sample that is currently embedded with the ensemble
will open a Save Audio File dialog box to ensure the sample exists on your hard drive and can
be located by REAKTOR. When this dialog box opens:

1. Navigate to a location to which you wish to save the current sample. Enter a name for the
file in the File name field. Note that if a file path exists, REAKTOR will just save to that
location without asking.

2. Click Save to save the sample.
If you click Cancel , the process will abort and leave the sample embedded in the ensemble.

To un-embed multiple samples:

1. Select the samples you want to un-embed in the Sample List.
2. Uncheck the Embed checkbox of one of samples.
3. A Save Audio File dialog box will open to ensure the sample exists on your hard drive and

can be located by REAKTOR.
4. When this dialog box opens, navigate to a location to which you wish to save the samples.

Enter a name for the file in the File name field. Note that if a file path exists, REAKTOR
will just save to that location without asking.

5. Click Save to save the samples.

When saving multiple samples, the Save Audio File dialog will only ask for the first selected
sample's file name, and will save all other samples to the same file path location under
their current names.

Sample Map Editing

In the Sample List View you can edit the Sample Map in various ways. The most important and
commonly used options are accessible as buttons below the Sample List.
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Sample List Edit Buttons

▪ Add: Opens a window to add a sample from your hard drive to the currently selected Sam-
ple Map.

▪ Replace: Similar to Add, but will load the new sample in place of a sample that was se-
lected in the Sample List.

▪ Save As: Opens a window allowing you to export a selected sample as a .wav or .aiff file.

▪ Remove: Deletes the currently selected sample(s).

Using the Remove command to delete embedded samples will remove the samples (i.e. au-
dio files) from the hard disk.

As well as the above, additional edits are also available by right-clicking (Mac OS X: [CTRL] +
click) on the list itself.

Sample List Edit Menu

▪ Note Actions: Quick mapping actions for selected samples.
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◦ Set Root Note to Low Note: Sets the Root value of the selected samples to their Low
value.

◦ Remap to Single Notes: Especially when working with Sample Maps where one drum
sample is assigned to each note, it can be time-saving to have REAKTOR automatical-
ly assign one note to each sample. If you want to take advantage of this feature, load
all the desired samples into the Sample Map and choose the Remap to Single Notes
menu entry.

▪ Clear Location: For selected embedded samples, removes the sample location informa-
tion.

▪ Reload: If the sample is not embedded in the ensemble, this command will update the
sample in REAKTOR if it was edited externally since the initial loading.

▪ Show in Folder: Opens a system folder at the location of the currently selected sample.

▪ External Edit: Opens the currently selected sample in a sample editing program (if speci-
fied in the Preferences).

▪ Sample Map: provides access to a number of additional import and export options via a
sub-menu:

◦ Import (merge): adds the content of the imported Sample Map to the already existing
one.

◦ Import (replace): replaces the current Sample Map with the imported one.

◦ Export including Audio Data: saves a Sample Map including samples (i.e. audio files.)
Audio data is included, which means the Sample Map file may get rather big in file
size. Use this option if you intend to share the resulting Sample Map file with other
users.

◦ Export with References Only: saves a Sample Map with file references. Audio data is
excluded, which means the Sample Map file will be very small in file size. The Export
with References Only option is only available when none of the samples are embed-
ded.

Improved Dragging and Dropping of Samples and Sample Maps

In REAKTOR 5.8, you can drag and drop files from the REAKTOR browser to the Sample Map
list is as follows:
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▪ Samples: adds the sample to the list

▪ Sample Maps: replaces the entire list

Holding down the [SHIFT] key on your computer keyboard before dropping the sample or Sample
Map adds these options:

▪ Samples: replaces the sample at the drop location.

▪ Sample Maps: merges the new sample map with the current list.

4.5.3 Keymapping View
 

The Keymapping View can be used to arrange the samples on a virtual keyboard, allowing you
to quickly define the root note, note ranges and velocity ranges of the currently loaded sam-
ples.

The Keymapping View is accessed by clicking on the Map button above the right half of the
Sample Map Editor.

The Keymapping View

The main area of the Keymapping View displays a virtual keyboard with the samples arranged
as boxes above it. These boxes show the current note range and velocity range of the samples.
The horizontal axis of this area represents MIDI notes, and the vertical axis represents MIDI
Velocity.
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The following edits are available via this area:

▪ To select a sample, clicking on a box (the selection will be reflected in the List View).

▪ To select multiple samples, click on an empty space and drag a lasso selection around the
samples you wish to select.

▪ To change the note range and root note for the sample, move the box. The root note is high-
lighted in blue on the virtual keyboard.

▪ To change the root note of the sample, click and drag the highlighted note on the virtual
keyboard.

▪ To change the velocity/note range of the sample, resize the box.

The current view range can be adjusted by using the scroll bars and zoom buttons to the bot-
tom and right of the Keymapping View.

With a single, or multiple selection of samples, you can use the value fields below this area to
enter exact data for the Sample Map:

▪ Root: Sets the root note of the sample. Commonly, this is the natural note of the sample.
If this note is played, no transposition will take place.

▪ Low: The lowest MIDI note that triggers the sample.

▪ High: The highest MIDI note that can trigger the sample. Any note between the Low and
the High will also trigger the sample.

▪ LVel: The lowest velocity that will trigger the sample. A MIDI velocity between this value
and the HVel setting will trigger the sample.

▪ HVel: The highest velocity that will trigger the sample.

The following additional functions are available in this area:

▪ Tune: Sets the tuning of the sample that is applied before any further transposition takes
place.

▪ Gain: sets a gain factor applied to the sample.

▪ Pan: sets a stereo panorama setting for the sample.

The Gain and Pan controls are not available for all sampler modules.
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The Keymapping View Context Menu

► To access a context menu that provides access to additional functions in the Keymapping
View, right-click (Mac OS X: [CTRL] + click) a selected note.

The context menu provides access to these options:

▪ Remove: Removes the selected sample(s).

▪ Set Root Note to Low Note: Sets the Root value of the selected samples to their Low val-
ue.

▪ Remap to Single Notes: Especially when working with Sample Maps where one drum sam-
ple is assigned to each note, it can be time-saving to have REAKTOR automatically assign
one note to each sample. If you want to take advantage of this feature, load all the de-
sired samples into the Sample Map and choose the Remap to Single Notes menu entry.

The Keymapping View context menu

4.5.4 Waveform View
 

The Waveform View can be used to view the waveform of the currently selected sample as well
as offering a selection of controls to alter the sample’s settings.

The Waveform View is accessed by clicking on the Waveform button above the right half of the
Sample Map Editor.
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The Waveform View

The main area of the Waveform View is of the waveform itself. Below the waveform is a selec-
tion of controls:

▪ Reverse: Check this box to play the sample backwards from the end of the sample, or the
end of the loop.

▪ Loop: toggles on or off the looping of the sample, or a portion of the sample.

Loop controls are not available for all sampler modules.

▪ Start: sets the start point of the loop (in samples)

▪ End: sets the end point of the loop (in samples)

▪ Alternate: checking this box will make the loop play forwards, then backwards alternately.

▪ Release: check this box to continue looping after a note off message.

▪ Phase Align: applies signal analysis to align grains (only available in granular modules)

If looping is active, it is possible to adjust the start and end times by clicking and dragging on
certain parts of the Waveform View:

▪ The flag at the start of the waveform will move the loop start time.

▪ The flag at the end of the waveform will move the loop end time.

What’s New in REAKTOR 5.8?

Sample Management

 

REAKTOR 5 - Manual Addendum - 59



▪ Clicking and dragging anywhere between these points will move both the start and end
times equally.

The looped area will be highlighted white, and the non-looped areas will be colored blue.

4.6 Updates to Mouse Controlled Elements
 

Mouse controlled elements are any panel elements that use the click-and-drag function to
change a value. These include:

▪ Knobs

▪ Faders (both horizontal and vertical)

▪ XY

▪ Mouse Areas

▪ Multi-Pictures

A number of changes have been made to the behavior of these elements in REAKTOR 5.8.

4.6.1 Fine-tuning
 

Fine-tuning is now available for mouse controlled elements. With fine-tuning activated, the
control will move more slowly, and with finer resolution, depending on the properties of the el-
ement.

► To activate fine-tuning, hold the [SHIFT] key on your computer keyboard as you click and
drag a control.
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Fine-tuning Factor

Fine-tuning is located to the bottom right.

Located in the Function tab of the properties window, the Fine-tuning Factor can be any posi-
tive integer value. This value will be multiplied to the Mouse Resolution value when the
[SHIFT] key is held.

Fine-tuning in Ensembles Saved before REAKTOR 5.8

Because the updates that enable fine-tuning may alter the behavior and sound of legacy en-
sembles, controls that were created in a REAKTOR version before 5.8 run in a special legacy
mode with fine-tuning disabled.

► To enable fine-tuning for such a control, click on the Fine-tuning Factor field that dis-
plays the text <not enabled>. This is an undo-able action but cannot be reverted once the
ensemble has been saved.

Apart from setting the fine-tuning factor to 10 and the step size to zero, enabling fine-tun-
ing for a legacy control may change the interpretation of its value stored in any snapshot,
preset or host project by the order of the step size.
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4.6.2 Other Updates
 

A variety of other updates have been applied to the controls. These updates will only be ap-
plied to controls created in REAKTOR version 5.8 or later, or to any control with fine-tuning
activated. Otherwise, they will function as before, in order to preserve compatibility.

Stepsize Defaults to Zero

A setting of zero for this property will mean that the output of the control is calculated as a
32bit floating point value between 0 and 1, which is then scaled to the Min and Max settings.

Num Steps removed from Properties

The Num Steps property has been removed, as it can be calculated from the Min, Max and
Stepsize properties. This also means that Stepsize property is given priority over the number of
steps when making changes to the Min and Max properties.

Mouse Resolution Ignored for anything but the Mouse and Keyboard

In REAKTOR versions prior to 5.8, the Mouse Resolution property would affect external con-
trols, including MIDI, OSC, host automation, as well as internal connections (IC send & re-
ceive). Now these values are only quantized by the Stepsize property, resulting in less rounding
errors and more predictable behavior.

4.7 Bookmark Behavior for Screensets
 

In REAKTOR 5.7 Screensets were introduced. Originally, the selected Screensets would be au-
tomatically updated as any updates to the current view were made. In REAKTOR 5.8, Screen-
sets can be changed to behave more like Bookmarks, and only be updated when they are creat-
ed, not when you navigate around the structure.

Activating Bookmark Behavior

To activate bookmark behavior for Screensets:

1. Enter the View menu
2. Navigate to Screensets
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3. Select and click on Bookmark-like Behavior to check this option

It is possible to switch between modes using this option, depending how you wish to work.

4.8 Updated Screenset Options
 

The following options are now available when right-clicking on a Screenset.

Expanded Screenset Options

▪ Rename: names of Screensets default to the name of the location of the Screenset, how-
ever a new name can be specified by selecting this option.

▪ Replace: over-writes the selected Screenset with the current view. (Only available when
Bookmark-like Behavior is active)

▪ Move Up: relocates the selected Screenset to one position up (moving Screenset 4 to po-
sition 3, for example). This will affect both the order of icons and the keyboard shortcuts.

▪ Move Down: relocates the selected Screenset one position down.

▪ Delete: removes the selected Screenset.

Updated Keyboard Shortcuts

The keyboard shortcuts for Screensets have been updated to replace the Panelset shortcuts for
faster navigation through the structure of an ensemble. Please refer to section ↑8, Keyboard
Shortcut Overview of this manual for the most up to date list of keyboard shortcuts.
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4.9 Updated Sample Rate Settings
 

The sample rate menu, accessed by clicking on the displayed sample rate display to the right
of REAKTOR’s header, has been updated with more options.

Sample Rate Menu

The sample rate menu contains three main categories, with a variety of options:

▪ Host/System: This option links REAKTOR’s sample rate to the host or system sample rate.
This is the default setting and probably the best to use for most cases.

▪ Fixed: Picking any of these options will fix the sample rate for the ensemble. This setting
will be saved with the ensemble and recalled whenever it is loaded. The options available
are multiples of the host/system setting and allow for internal over-sampling.

▪ Factor: Select from any of these options to increase or decrease the internal sample rate
as a factor of the system/host sample rate. This setting is a REAKTOR preference and will
be recalled when you next open REAKTOR (unless you open an ensemble with a fixed
sample rate).
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5 What’s New in REAKTOR 5.7?

 

Welcome to REAKTOR! This manual addendum provides information about the new features in
version 5.7 of REAKTOR. Here is a brief overview of the most important changes and addi-
tions:

▪ Improved loading times (↑5.1, Compiled Core Cell Code Cache)

▪ ↑5.2, Explicit Play and Edit Modes

▪ ↑5.3, Screensets

▪ ↑5.4, Universal Wire Debugging Mode

▪ ↑5.5, Layout and Transport Changes

5.1 Compiled Core Cell Code Cache
 

When opening an Ensemble with large Core Cell structures in REAKTOR 5.7, a cache file of
the compiled Core Cell code is saved on your hard drive. When you next load the Ensemble,
REAKTOR will access this cache file, allowing it to skip this compiling stage of the loading
process to significantly decrease loading times.

Important Details of the Compiled Core Cell Code Cache Feature

▪ The Compiled Core Cell Code is only used when REAKTOR is in Play Mode (see ↑5.2.1, Play
Mode).

▪ Switching to Edit Mode (see ↑5.2.2, Edit Mode) when using Ensembles with large Core Cell
structures causes a re-load of the Core Cells, which can cause REAKTOR to pause momentar-
ily.

▪ The loading time optimization only works for Ensembles saved with REAKTOR 5.7 or later.

Default Cache Location

The default location of the Compiled Core Cell Code Cache is:

▪ On Windows: …/<user>/AppData/Local/Native Instruments/Reaktor5/Cache/
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▪ On Mac OSX: …/<user>/Library/Application Support/Native Instruments/Reaktor5/Cache/

Changing the Compiled Core Cell Code Cache Location

To change the Compiled Core Cell Code Cache location:

1. Open the Preferences window by clicking on Preferences… in the File menu or by press-
ing [Ctrl] + [,] on PC or [Cmd] + [,] on Mac.

2. Navigate to the Directories tab. At the bottom of the Directories tab you will see an area
labeled Compiled Core Cell Code Cache.

3. To change the Cache location, either click the browser button on the left to locate the tar-
get directory on your system, or type in the location manually.

4. Close the window.
5. If your operating system prompts you, allow REAKTOR to make changes to your hard

drive.

Purging the Compiled Core Cell Code Cache

To delete all unused or corrupt files from the Cache directory, click on the Purge button in the
Compiled Core Cell Code Cache preferences. These files will be deleted:

▪ Any Compiled Core Cell Code file for which the parent Ensemble can no longer be found

▪ Any corrupt Compiled Core Cell Code files

You can remove all of the files in the Cache manually, but REAKTOR will re-create the Com-
piled Core Cell Code files the next time you load Ensembles containing large Core Cell struc-
tures in Play mode.

5.2 Explicit Play and Edit Modes
 

New in REAKTOR 5.7 are dedicated Play and Edit modes that optimize REAKTOR for playing
and for editing Ensembles.
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5.2.1 Play Mode
 

REAKTOR 5.7 introduces a new Play Mode, which optimizes REAKTOR for the case of using,
rather than editing Ensembles. The main benefits of Play Mode are:

▪ Streamlined interface to maximize the Ensemble Panel space: In Play mode, all of the editing
controls are hidden and disabled, presenting a more streamlined workspace for those who
do not need all of the editing capabilities of REAKTOR, but want to use instruments and
effects built in REAKTOR.

▪ Optimized loading times for Ensembles: Play Mode is required to be active in order for RE-
AKTOR to use the new Compiled Core Cell Code Cache, and so can decrease loading
times of larger Ensembles significantly.

▪ Easier use of REAKTOR as a plug-in: Play Mode also makes working with REAKTOR as a
plug-in easier by disabling any control options that are not saved in a Host Chunk — that
is to say, any options that require you to save the Ensemble file when you are using RE-
AKTOR as a plug-in. This means you no longer need to worry about the auto-save func-
tions and host recall for your projects.

Features and Options Unavailable in Play Mode

The following controls and options are disabled when using Play Mode:

▪ Entering the Ensemble structure

▪ Editing the Panel

▪ Storing and recalling Panelsets

▪ Viewing or editing the properties of any element

▪ Changing the Control Rate or Sample Rate

▪ Snapshot and Bank editing (though loading snapshots is still possible, saving is only pos-
sible by saving with the Host Chunk or by saving a single preset)

▪ Sample Map editing

▪ MIDI Learn
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5.2.2 Edit Mode
 

Toggle Edit Mode

REAKTOR 5.7 now has an explicit Edit Mode that is similar to the classic workspace of previ-
ous REAKTOR versions. In this mode, all of the controls related to changing the structure or
options of an Ensemble are present and visible.

► To activate Edit Mode, click on the button with the Structure icon to the left of the Snap-
shot Selection menu in the Header or use the keyboard shortcut [F1].
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A comparison of Sinebeats2 in Edit Mode on the left, and in Play Mode on the right

The Edit Mode setting is persistent between sessions when using REAKTOR in stand-alone
mode. If you use REAKTOR mainly to build or edit your own Ensembles, it is possible to acti-
vate Edit Mode and leave REAKTOR in this state for each time you return to it.

Creating a new Ensemble will automatically activate Edit Mode.
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5.3 Screensets
 

Screensets are a new tool to help you navigate your Ensembles. They are located in the side-
bar, below the Debug and MIDI Learn buttons.

The Screensets are located in the sidebar

Screensets are like Bookmarks from previous REAKTOR versions, but include two major im-
provements: the use of keyboard shortcuts, and saving the state of your workspace — your cur-
rent workspace set up is automatically saved in your currently selected Screenset.

The icon for a specific Screenset depends on its contents (Pane, Structure, or both) and the
orientation of the screen split (if used).

Any Ensembles created or saved in a REAKTOR version earlier than 5.7 will have their
Bookmarks imported as Screensets. A new Ensemble will automatically have two Screen-
sets: The Panel, and the Ensemble structure.
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5.3.1 Creating Screensets
 

To create a new Screenset, either

► click the + button below the Screensets, or

► pressing [Ctrl] + [T] ([Cmd] + [T] on Mac) on your computer keyboard.

5.3.2 Deleting Screensets
 

To delete a Screenset, either

► right-click the Screenset icon and select Delete Screenset, or

► close all of the Panes in the workspace.

[Ctrl] + [F4] ([Cmd] + [W] on Mac) closes your current Pane. If this closes the Screenset,
then it is removed from the list.

5.3.3 Navigating Screensets
 

The following keyboard shortcuts have been added to make navigation of your Ensembles even
quicker and easier.

Action Mac OS X Windows

Append Screenset [Cmd] + [T] [Ctrl] + [T]

Recall Screenset 1…8 [Ctrl] + [Cmd] + [1…8] [Ctrl] + [Alt] + [1…8]
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Action Mac OS X Windows

Next Screenset [Ctrl] + [Tab] [Ctrl] + [Tab]

Previous Screenset [Ctrl] + [Shift] + [Tab] [Ctrl] + [Shift] + [Tab]

Close Pane / Screenset [Cmd] + [W] [Ctrl] + [F4]

► To select a specific Screenset, click on the corresponding icon.

5.4 Universal Wire Debugging Mode
 

In REAKTOR 5.7 there is no longer a distinction between debugging wire values in Primary or
Core. Instead, there is now one universal debugging mode that remains persistent when navi-
gating between Core and Primary structures. As an added benefit, viewing the values of cables
in Primary is now no longer linked to the Info Hints setting.

► To activate Wire Debugging Mode, either click on the bug icon below the MIDI Learn but-
ton in the Sidebar, or press [Ctrl] + [B] ([Cmd] + [B] on Mac).

Enable Wire Debugging

► To view a wire's value, hover the mouse cursor over the wire.

The format in which the values are presented have been updated slightly to highlight the dif-
ference between wire values and Info Hints.

A comparison between Info Hints (left) and a wire value (right)

5.5 Layout and Transport Changes
 

The main changes to the layout of REAKTOR 5.7 are:
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▪ Edit Mode button in Header.

▪ Changes to the Sidebar to include Screensets.

▪ Audio Recorder and Player have moved into the Header area.

Updated transport controls.

The Updated Header, including the Recorder Bar

The Transport controls have been updated to work in a more logical fashion:

▪ The Play button starts and pauses playback.

▪ The Restart button sets the Song Position to zero, but will not alter the playback state.
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6 What's New in REAKTOR 5.6.2?

 

The following are a list of changes introduced before 5.7, but that are still applicable to the
addendum:

▪ 64-bit support for Windows and OS X

▪ New Module Reference manual

▪ Simplified handling of Snapshots

▪ Easily save the state of an existing Ensemble as a Preset file

▪ Quickly navigate Structures using the breadcrumb navigation feature

▪ Scroll the Structure with [Alt]+Drag

▪ Show the previous Structure with [Alt]+[B]

▪ Show the contents of a Macro in the other Split Pane with [Alt] + double-click on the
Macro

▪ Add Objects to the Structure using the Searchbox (just press [Enter] in Structure View)

▪ Delete Objects and Wires using [Backspace] or [Delete]

▪ Duplicate Objects with [Ctrl] + Drag ([Alt] + Drag on OS X)

▪ Drag copies of Objects to the other Split Pane with [Ctrl] + Drag ([Cmd] + Drag in OS X)

▪ Navigate to the parent folder in the Browser's folder tree with Left Arrow

▪ The Recorder Bar now shows the recorded time when recording

▪ The XY Module now features the "transparency" and "hide frame" properties

▪ Improved loading time for Ensembles with many Send and Receive Modules

▪ Added "Abort" function to the File Not Found dialog upon project recall

▪ Changed keyboard shortcuts
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Bug fixes and latest changes of this update are documented in the README.TXT file which
was copied to your hard disk along with this document. For all other questions regarding RE-
AKTOR, please refer to the Getting Started Manual, Application Reference, and Module Refer-
ence. This addendum assumes that you have a basic understanding of what is explained there.

6.1 Improved Structure Navigation
 

REAKTOR version 5.6.2 now comes with a number of usability enhancements that make navi-
gating Structures a breeze.

6.1.1 Breadcrumb Navigation
 

The breadcrumb navigation feature lets you directly access different hierarchy levels of the
Structure. This feature is activated when Edit mode is turned on. The breadcrumb navigation
basically displays a view of the hierarchical levels above the currently shown Ensemble Struc-
ture. To jump to a higher level, just click its entry in the path display. REAKTOR also displays
the last lower-level Structure you visited, so that you can quickly return to that Structre's level
with a mouse click. For a walkthrough of the breadcrumb feature, follow these instructions:

1. First, open an existing Ensemble with at least a couple of Structure hierarchy levels. Here
we use Padecho.ens, found in the Factory Content section of the Browser. More precisely,
it is located under Ensembles > Tutorial Ensembles > Padecho.ens.
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2. Make sure you are in the Ensemble's Panel View, as shown in the figure below.

3. Now turn on the Ensemble's Edit mode by using the keyboard shortcut [F1] or by pressing
the Edit button, shown in the figure below.

4. Now you should see the breadcrumb navigation, as shown in the figure below. It displays
a hierarchical view of the Ensemble Structure, including the Panel. The current location is
highlighted. In our case we are in Panel View, so the Panel entry in the path interface is
highlighted (see figure below). To navigate one level down in the Structure using the
breadcrumb navigation, left-click the next path element.
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5. As expected, you have navigated one level down in the Structure. Accordingly, the corre-
sponding path entry is highlighted. This is shown in the figure below.

6. Now let's split the Structure by left-clicking the Horizontal Split button, shown in the fig-
ure below. Alternatively you can use the keyboard shortcut [F2].

7. You should see the Split View with two Structures, as shown in the figure below. Note that
each Split Pane has its own breadcrumb navigation interface. In the top Pane, navigate
one level deeper into the Structure. The breadcrumb navigation shows the lowest level in
the Structure navigated to. In the case of the figure below, the Master Instrument was the
lowest Structure level visited. The idea of the breadcrumb navigation is to easily navigate
through complex Structures. If the breadcrumb navigation does not display all of the
Structure's levels, just navigate as usual by double-clicking the desired Objects in the
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Structure. This will add the levels you have visited to the breadcrumb navigation bar. Both
Split Views have their own breadcrumb navigation interface:
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→ The figure below shows the result of the last navigation operation. Each of the Split
Panes can be navigated independently with their own breadcrumb navigation interfaces.

To quickly toggle between the Panel View and the current Structure View:

► Press the Edit button (or [F1] key on your computer keyboard), shown in the figure below.

Use the Edit button to toggle the Edit mode on and off.

► Alternatively, you can use the Close button, shown in the figure below, to close a Split
Pane. If only one Structure Pane is shown, pressing the Close button directly navigates
you to the Panel View. Pressing the Close button in Panel View turns the Edit mode off.

The Close button at the very right of the breadcrumb navigation interface.
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If you have reached Panel View by repeatedly pressing the Close button as described above
and you then press the Edit button, you will return to the Split Pane setup displayed before
you first pressed the Close button. That is, even if you first closed a Structure Split Pane, you
will be returned to the Split View.

6.1.2 Other Structure Navigation Improvements
 

Opening a Macro in the Other Split Pane

► To show the contents of a Macro in the other Split Pane, double-click the Macro while
holding down the [Alt] key. This is shown in the sequence of two figures below. The red
outline indicates that the displayed Structure is indeed the contents of the Macro.

This also works for Instruments, Core Cells and Core Macros.

Open the contents of a Macro in the other Split Pane by double-clicking it while holding down the [Alt] key.
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The breadcrumb navigation interface indicates that the content of the Structure is indeed that of the [Alt] + double-clicked
Macro.

You can also perform the same action by right-clicking the Macro and selecting the Struc-
ture in other Pane menu entry.

Scrolling the Structure with the Mouse

► You can now scroll the Structure by clicking and dragging the Structure background while
holding down the [Alt] key. During this operation the mouse cursor should change shape.
This is shown for the case of Windows in the figure below.
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Scroll the Structure by clicking and dragging while holding down the [Alt] key.

6.2 Improved Object Manipulation
 

In addition to the navigation improvements discussed in the previous chapter, building in RE-
AKTOR has now been made faster and more efficient in a number of ways. For example, you
can use the Searchbox to directly type in the name of the Object you wish to load without hav-
ing to search around for the right menu entry. Also, new keyboard shortcuts have been imple-
mented so that you can quickly duplicate Objects, even between different Split Panes.

6.2.1 Adding Objects with the Searchbox
 

To add Objects to the Structure using the Searchbox, follow the instructions below:

1. With the keyboard focus in the Structure View, press the [Enter]/[Return] key or use the
combination [Ctrl]+[F] in Windows ([Cmd]+[F] in Mac OS X). This opens up the Search-
box, as shown in the first figure below.

 
Alternatively, you can right-click the Structure background and choose the Insert Module
… menu entry. This is shown in the second figure below.
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2. Once the Searchbox has been opened, start typing the name of the Object you wish to
place into the Structure. As shown in the figure below, typing "Sine Bank" narrows down
the menu of Objects down to the Sine Bank Oscillator Module and the Sine Bank Macro.

3. Now choose the Object you wish to load by navigating to the corresponding menu entry
using the [Up] and [Down] Arrow keys or simply by clicking on the menu entry.

4. After having added some Objects with the Searchbox notice how the last eight Objects
you added automatically appear in the Searchbox menu before you have typed anything in
the edit field. This is shown in the figure below.

→ The last eight Objects that were added using the Searchbox appear in the menu right af-
ter opening the Searchbox.
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If you wish to close the Searchbox without adding anything to the Structure, just press the
x icon at the right of the Searchbox (or the [ESC] key on your computer keyboard).

6.2.2 Other Structure Workflow Improvements
 

Additionally to the Searchbox, improvements have been made in the way Objects are removed,
copied, and duplicated in Structure View.

Deleting Wires and Objects Using Backspace or Delete

► To delete a Wire or Object from the Structure, just select the desired element and press
the [Backspace] or [Delete] key. A selected Wire is shown in the figure below.

You can now use either the [Backspace] key or [Delete] key to remove Objects and Wires from the Structure.

Duplicating Objects with Ctrl-Drag

► You can now quickly duplicate Objects in the Structure by holding down [Ctrl] in Win-
dows ([Alt] in Mac OS X) and then clicking an Object and dragging to an empty part of
the Structure. A duplicate of that Object will appear at the site of the Structure where
you release the mouse button. This sequence of two steps is shown in the two figures be-
low.
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To duplicate an Object, hold down [Ctrl] in Windows ([Alt] in Mac OS X) and click and drag the Object to an empty part of
the Structure.

The duplicate Object will appear in the part of the Structure where you release the mouse button.

Copying Objects to the Other Split Pane

► You can now easily copy Objects from one Structure Split Pane to the other by holding
down [Ctrl] in Windows ([Alt] in Mac OS X) and then clicking and Object and dragging to
an empty part of the other Split Pane. A duplicate of the selected Object will appear at
the site of the other Split Pane Structure where you release the mouse button. This se-
quence of two steps is shown in the two figures below.

What's New in REAKTOR 5.6.2?

Improved Object Manipulation

 

REAKTOR 5 - Manual Addendum - 85



To copy an Object to the other Split Pane Structure, hold down [Ctrl] in Windows ([Alt] in Mac OS X) and click and drag the
Object to an empty part of the other Split Pane Structure.

A copy of the Object will appear in the part of the other Split Pane Structure where you released the mouse button.

6.3 Miscellaneous Improvements
 

This chapter covers various improvements, such as new hat propeties in the XY Module, 64 Bit
compatibility, quicker Browser navigation and the improved Recorder Bar display.

6.3.1 XY Module
 

The XY Module now features the transparency property and the option to hide the frame in
Panel View.
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Panel Element Transparency Setting

1. To turn on transparency for the background of the XY Module's Panel Element, first go to
the Module's Properties View.

2. Then enter the View page.
3. Now enter the desired transparency value into the Background Color Transparency edit

field, shown in the figure below. '100' corresponds to completely transparent and '0' cor-
responds to completely opaque.

4. The result of an 80% transparency value is shown in the figure below. If need be, go to
the Instrument's Panel View to see the result of your transparency setting.

Hiding the Panel Element's Frame

1. To hide or display XY Module's frame in Panel View, first go to the Module's Properties
View.

2. Then enter the View page.
3. To hide the XY Module's frame, disengage the Has Frame checkbox, shown in the figure

below. On the other hand, to display the frame, make sure the Has Frame checkbox is en-
gaged.
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4. The result of hiding the Panel Element's frame is shown in the figure below. If need be,
go to the Instrument's Panel View to see the result of hiding the frame. The XY Module's
Panel Element without the frame:

6.3.2 64 Bit Support
 

REAKTOR is now compatible with 64-bit processor architectures. This will enhance your RE-
AKTOR experience provided that you are running REAKTOR on a computer that utilizes a 64-
bit processor. On 64-bit Windows operating systems, you can select where to install the 32-bit
and 64-bit plug-in versions of REAKTOR during the REAKTOR installation procedure.

Mac OS X: Switching between 32-Bit and 64-Bit Mode

In Mac OS X you can switch between running REAKTOR in 32-bit and 64-bit modes:

1. To switch between running REAKTOR in 32-bit and 64-bit mode (in Mac OS X), open the
Get Info window by pressing [Cmd]+[F] on the Reaktor 5.app in the OS X "finder" applica-
tion.

2. Then use the Open in 32-bit mode checkbox to toggle the 32-bit mode on and off. This is
shown in the figure below.

What's New in REAKTOR 5.6.2?

Miscellaneous Improvements

 

REAKTOR 5 - Manual Addendum - 88



Engage the "Open in 32-bit mode" checkbox to run REAKTOR in 32-Bit mode (in Mac OS X).

6.3.3 Browser Navigation
 

Browser navigation has been improved by letting you navigate to the parent folder in the
Browser's folder tree with the left Arrow key. The instructions below demonstrate this feature:
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1. Open the Browser and in the folder tree, navigate to a folder which lies within another
folder. This is shown in the figure below, where the folder tree has the Tutorial Ensembles
folder selected. This folder lies within the Ensembles folder.

2. Now press the left Arrow. If the selected folder is in its "closed" state, this will select the
parent folder. In our case this is the Ensembles folder, shown in the figure below. 
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3. Press the left Arrow key again. In the case of an "open" folder, this closes the folder's
branch in the folder tree, as is shown in the figure below. The right Arrow key opens the
folder in the folder tree again.

6.3.4 Recorder Bar
 

The Recorder Bar now conveniently displays the length of the time interval recorded. This is
shown in the figure below.

The Recorder Bar displays the recorded time of the current recording.

6.3.5 Supported Graphics Formats
 

As from REAKTOR 5.6, Modules capable of loading graphics files support the PNG file format,
in addition to TGA and BMP graphics files. Independent of the file format, the loaded graphics
files can be used as Picture, Multipicture, Knob, etc.
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6.4 Snapshots
 

How to Read this Chapter

REAKTOR 5.6.2 features simplified Snapshot handling. Additionally, you can easily save and
load the complete state of an existing Ensemble as a handy Preset file. This chapter may be
read in two ways, depending on what you already know about the Snapshot tab:

▪ If you are already familiar with the Snapshot tab of REAKTOR 5.5, and have read the
chapter on the Snapshot tab in the Application Reference, you can get a good overview of
the differences between the new and old Snapshot behavior by just reading sections
↑6.4.8, Defining Snapshot Behavior for Instruments and ↑6.4.9, Opening and Saving Pre-
sets. Use the cross-reference links to directly jump to these sections.

▪ For those who are not yet familiar with REAKTOR's Snapshot tab, you should read the
whole chapter, as it contains a complete guide to using the Snapshot tab, including the
new features.

What are Snapshots?

Snapshots (also known as patches, programs, or presets) enable you to store and recall an In-
strument's sounds. When you create a Snapshot, the current settings of all the Instrument's
Panel controls and MIDI controllers are stored in the Snapshot. Among the Panel controls, set-
tings like the knob and fader positions, list box and switch settings, and button states are
saved. When you recall a Snapshot, all the Instrument's controls are restored to the settings
they were in when the Snapshot was originally created. Each REAKTOR Instrument can store
16 Snapshot Banks containing 128 Snapshots each, for a total of 2048 Snapshots. In this
chapter you will learn how to recall and create Snapshots in addition to working with Snapshot
Banks and features like “Snapshot Compare” and “Snapshot Randomize”. All of these features
are accessed from the Snapshot tab (see below).
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The Snapshot tab lets you do all the possible Snapshot operations in REAKTOR.

6.4.1 Recalling Snapshots
 

There are five different methods you can use to recall an Instrument's Snapshots:

▪ The first way to recall a Snapshot is by using your mouse to select the desired Snapshot
from the Snapshot drop-down menu in the header, shown in the figure below. When using
REAKTOR as a plug-in, it is this Ensemble Snapshot List which is forwarded to the host
application. The Snapshot List always shows the Snapshots of the Ensemble or Instru-
ment set as the Snapshot Master (see subsection ↑6.4.8, Defining Snapshot Behavior for
Instruments). The Snapshot drop-down menu looks like this:

▪ You can also use your mouse to select Snapshots from the Snapshots drop-down menu in
the Instrument Header (shown in the figure below). With the Instrument header selected,
you can use the Up and Down arrow keys on your computer keyboard to select previous
and next Snapshots, respectively. The Snapshot drop-down menu in the instrument head-
er:
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▪ Another option is to go to the Snapshots tab. In the Snapshot tab you first need to select
the desired Instrument (or Ensemble) for which the Snapshot recall is to take place. This
is done using the Select Instrument drop-down menu shown in the figure below. Then
click on the Snapshot you wish to recall in the Snapshot List.

▪ Additionally, you can select Snapshots by sending MIDI Program Change messages from a
MIDI keyboard (or some other MIDI device). For this to work, the Recall by MIDI checkbox
in the Function page (see subsection ↑6.4.8, Defining Snapshot Behavior for Instruments)
of the corresponding Instrument's Properties should be engaged. The MIDI Program
Change message selects a Snapshot by its number (an integer in the range [0 … 127]). A
Program Change value of “0” selects the first Snapshot, a Program Change value of “1”
selects the second Snapshot, and so on. The Recall by MIDI checkbox:

▪ Last, if you are a REAKTOR builder, you can use the Snapshot Module to recall, store,
randomize, and morph Snapshots. Please read the entry of the Snapshot Module in the
Module reference for more information on this Module.

Parent and Child Instruments

Any Instrument that contains another Instrument is called a "parent" Instrument. For example,
an Ensemble (top-level Instrument) that contains another Instrument is a "parent" Instrument.
A "child" Instrument is an Instrument that is contained within another ("parent") Instrument.

Recalling a "parent" Instrument's Snapshot recalls the Snapshots of "child" Instruments as
well, but only if the Snap Isolate checkbox in the respective Instrument's Function page is dis-
engaged (see section ↑6.4.8, Defining Snapshot Behavior for Instruments for more information
on this).

Note that recalling a "parent" Instrument Snapshot not only recalls the "child" Instrument's
Snapshot that was loaded at the time of storing the "parent" Snapshot, but also sets the "child"
Instrument's controls to the state in which the "parent" Snapshot was stored.
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Selecting the Instrument for the Snapshot List

If you have several Instruments in your Ensemble, there will be a Snapshot List for each of
these Instruments in the Snapshot tab. This will be the case even if some of these Instruments
have no Snapshots at all; that Snapshot List will then be empty. The Snapshot tab can only
display one Snapshot List at a time. How do you choose the Instrument for which the corre-
sponding Snapshot List should be displayed? There are two ways:

▪ You can select the Instrument for which the Snapshots are displayed in the Snapshot List
from the Select Instrument drop-down menu.

▪ Another option is to activate the Linked button. If this button is activated, the Snapshot
List is linked to the Panel View. This means that if you select an Instrument in Panel
View, its Snapshot List is automatically displayed in the Snapshot tab. If the Linked but-
ton is not active, you must use the Select Instrument drop-down menu explained above to
manually choose which Instrument's Snapshots are displayed in the Snapshot List.

► To select the Ensemble Snapshot List with the Linked button activated, click an empty
area of the Panel View where there is no Instrument Panel.

Making a Control Immune to Snapshot Recall

When you select a Snapshot, the Panel controls and MIDI controllers jump to their positions as
stored in the Snapshot. In some cases you might not want this to happen. For example, you
might create a sequencer with a BPM (tempo) knob whose settings you want to be independ-
ent of the Snapshot. To prevent a Panel control or MIDI controller from jumping to the position
designated by the Snapshot, follow these instructions:

1. Double-click on the desired control like a knob, fader, list, or button.
2. This should have opened up the control's Properties View. Now click on the Function but-

ton:

3. Engage the Snap Isolate checkbox in the Snapshots area of the control's Function page:
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Control IDs

Every REAKTOR Panel control has a unique ID number, as displayed in the ID for Files edit
field in the control's Function page. This ID number is called the Control ID, and it is shown in
the corresponding Edit field (see below).

The ID for Files edit field holds the value by which a Snapshot identifies the Panel control.

REAKTOR lets you change these Control IDs. Before you do so, you have to be aware of a few
dangers that are tied to this. Snapshots assign specific (control) values to specific Control IDs.
For example, Snapshot 1 might assign the value “0.5” to a knob with the Control ID “112”
and the value “0.75” to a fader with the Control ID “222”, and so on. If you change the knob
and fader Control IDs, it will change the values that Snapshot 1 assigns to these controls. Thus
you can break Snapshots which you have worked on so arduously.

Do not change the Control ID Numbers unless you really have to. Be aware that changing Con-
trol ID Numbers breaks the Snapshots which were used for these controls.

6.4.2 Adding and Removing Snapshots
 

The basic operations that you can do with the Snapshot List are to add, overwrite, and remove
Snapshots. This section describes which buttons you need to press for the different Snapshot
List operations. Before pressing these buttons, though, you need to make sure that you are
working with the Snapshot List of the intended Instrument. You can see which Instrument is
selected with the Select Instrument drop-down menu. Also, you need to click the Append,
Store, and Insert buttons twice for these operations to be finalized. The first click lights up the
button and places a blinking cursor in the appended, stored, or inserted Snapshot slot, giving
you the opportunity to type a name for it. The second click dims the button and saves the ap-
pended, overwritten, or inserted Snapshot.
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The Select Instrument drop-down menu

Remember to click twice! If you forget the second click, you might end up doing something
very different from what you intended.

Appending Snapshots

If you want save the current Instrument settings as a new Snapshot to the first empty slot in
the corresponding Snapshot List, then use the Append button in the Snapshot List Operations
area. If the current Snapshot Bank is full, pressing the Append button causes the Snapshot to
be saved to the first empty slot in the next Snapshot Bank. If there are no more empty Snap-
shot Slots, pressing the Append button causes nothing to happen. This would be the case
when you have used up all 16 Snapshot Banks, each filled with 128 Snapshots.

The Append button

Inserting Snapshots

You can also save the current Instrument settings as a new Snapshot that is inserted into the
Snapshot List directly after the selected Snapshot. To do this, press the Insert button in the
Snapshot List Operations area. Note that this can cause Snapshots to move from the current
Bank to the next Bank.

The Insert button

Overwriting Snapshots

To replace the selected Snapshot with the current Instrument settings, use the Store button.
Note that when you overwrite a Snapshot in this way, you lose its original settings.

The Store button
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Saving a "parent" Instrument's Snapshot saves the Snapshots of "child" Instruments as well,
but only if the Snap Isolate checkbox in the respective Instrument's Function page is disengag-
ed (see section ↑6.4.8, Defining Snapshot Behavior for Instruments for more information on
this). Not only is the currently loaded "child" Instrument's Snapshot saved, but also the state of
the Instrument's controls, even if a separate "child" Instrument Snapshot for that state doesn't
exist.

The different areas of the Snapshot tab
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Deleting Snapshots

If you want to delete one or more Snapshots from the Snapshot List, select the Snapshots and
either press the Del key on your computer keyboard or choose the Delete selected Snapshots
menu entry from the Edit Bank drop-down menu, as shown in the figure below.. Note that de-
leting Snapshots creates empty slots in the Snapshot List; you can use the Sort and Compress
Snapshots entry from the Edit Bank drop-down menu to remove these gaps (see subsection
↑6.4.7, Snapshot Banks).

The Delete selected Snapshots menu entry.

Setting Instrument Settings to Default Values

You can change the settings of all Instrument controls (which do not have the Snap Isolate
checkbox engaged, see section ↑6.4.1, Recalling Snapshots) to their default values. The De-
fault value for a control is set with the Default edit field in the corresponding Module's Func-
tion page. You set the Instrument controls to their Default values by choosing the Recall de-
fault values menu entry (see figure below) from the Edit Bank drop-down menu. This changes
the selected Snapshot's settings, but does not save the changed Snapshot. To do this, you
must subsequently press the Store button.

The Store button
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► Use the Set control values as default and Recall default values menu entries to set and
recall default settings.

Setting Control Values as Default

You can acquire the current settings of all of the Instrument's controls as the Default values to
be used when the state of a control is to be reset. This is also the case when applying the
Recall default values menu entry discussed above.

6.4.3 Renaming and Copying Snapshots
 

Since there are no explicit “rename” and “copy” operations in the Snapshot tab, these two
common tasks will be explained in this section.

Renaming Snapshots

There are two ways to rename an existing Snapshot in the Snapshot List:

▪ Double-click on the Snapshot and type the desired name. Then press the Enter key on
your keyboard to save the renamed Snapshot.

▪ Alternatively, select the Snapshot and click on the Store button. Next you must type in
the desired name and then click on the Store button once more to save the renamed
Snapshot.
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Copying Snapshots

As with renaming, there are two ways to copy Snapshots within the Snapshot List of an Instru-
ment:

▪ For the first way select the Snapshot, then click on the Append button. Next rename the
appended Snapshot if desired, and the click on the Append button a second time to save
the appended Snapshot. Note that this copies that Snapshot to the first empty slot in the
Snapshot List.

▪ You can also first select the Snapshot, then click on the Insert button. Following that, re-
name the inserted Snapshot if desired, and then click on the Insert button once more to
save the inserted Snapshot. Note that this copies the Snapshot to a new slot below the
originally selected slot in the Snapshot List.

6.4.4 Comparing Snapshots
 

REAKTOR makes sound design easy for you by letting you compare a Snapshot with a modified
version of the same Snapshot or with another, completely different Snapshot. This section de-
scribes how to do these two tasks. The basic idea behind the “Compare” feature is simple. The
modified (or different) Snapshot is stored in the “compare buffer”, and the Compare Snapshot
menu entry is used to toggle between the original Snapshot and the modified (or different)
Snapshot.

The Compare Snapshot menu entry in the Edit Bank drop-down menu
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Comparing an Original Snapshot with a Modified Version

To compare a Snapshot with a modified version of the same Snapshot, follow these instruc-
tions:

1. Make sure you have an Instrument open.
2. Open the Snapshot tab.
3. Select a Snapshot in the Snapshot List.
4. Make sure there is no checkmark in fron of the Compare Snapshot menu entry in the Edit

Bank drop-down menu.
5. Modify the settings of the Instrument controls as desired.
6. Use the Compare Snapshot menu entry in the Edit Bank drop-down menu to toggle be-

tween the original and modified Snapshot versions.
7. If you want to make further modifications, repeat instruction steps 5-6.

Comparing Two Different Snapshots

To compare two different Snapshots in the Snapshot List of an Instrument, follow these in-
structions:

1. Make sure you have an Instrument open with at least two Snapshots.
2. Open the Snapshot tab.
3. Select a Snapshot in the Snapshot List.
4. Next, select another Snapshot in the Snapshot List. The first Snapshot is now stored in

the “compare buffer”.
5. Now you can use the Compare Snapshot menu entry in the Edit Bank drop-down menu

(shown in the figure above) to toggle between the two Snapshots.

If you are modifying a Snapshot and accidentally select a different Snapshot, you can re-
cover your modifications by clicking on the Compare button right away (before you make
any changes to the new Snapshot).
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6.4.5 Morphing between Snapshots
 

Not only can you compare two Snapshots, but you can even morph between them, that is,
change an Instrument's Panel control settings gradually (over a time interval of [0 … 60] sec-
onds) from their values in one Snapshot to their values in another Snapshot. The Snapshot
Morph area (see below), holds the controls for morphing between Snapshots.

The Snapshot Morph area in the Snapshot tab lets you morph between two Snapshots in the Snapshot List.

To morph between two Snapshots, follow these instructions:

1. Make sure you have an Instrument open with at least two Snapshots.
2. Open the Snapshot tab with the desired Snapshot List. If the Snapshot Morph area de-

picted in the figure above is not open, press the arrow button next to the text "Snapshot
Morphing and Random", shown below.

3. Set your desired morphing time in seconds (a value in the interval [0…60]) in the Morph
Time edit field. This value determines how long it will take the controls to morph (move)
from their current settings to their new settings.
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4. Next click on the Select A button to activate it (the text will change to "Select…").

5. Then select the first of the two Snapshots (Snapshot A) between which you want to morph
from the Snapshot List.

6. Now click the Select B button to activate it (it is the button that lies symmetrically to the
Select A button to the right).

7. Select the second of the two Snapshots (Snapshot B) from the Snapshot List.
8. Gradual, incremental change between two Snapshots is the basis of morphing. Because

button and switch settings cannot be changed gradually, REAKTOR does not let you
morph them. Therefore, before you begin to morph, you must decide whether to use the
button and switch settings from Snapshot A or Snapshot B. To use the button and switch
states from Snapshot A, press the State A button to the left of the Morph slider (see be-
low). The button should light up. Alternatively, to use the button and switch states from
Snapshot B, press the State B button to the right of the Morph slider (in this case this
button should light up).

9. Now you are ready to morph between the two Snapshots. Move the horizontal Morph slider
(see figure below) to a new position. When the slider is set fully to the left, the Instrument
control settings (except perhaps the button states) correspond purely to Snapshot A. Simi-
larly, when the slider is set fully to the right, the control settings correspond to Snapshot
B. A slider setting right in the middle corresponds to an arithmetic average between the
control settings of the two Snapshots, that is, 50 % of Snapshot A and 50 % of Snapshot
B. Other slider settings have analogous results. After moving the Morph slider to a new
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position, the Instrument's controls will move from their current settings to the settings
specified by the new Morph slider position in a time interval of the number of seconds
specified in the Morph Time edit field (see figure below).

Once you have configured the morph settings you can use the Morph slider to morph between two Snapshots.

Morphing a Snapshot of a "parent" Instrument morphs the controls of "child" Instruments as
well, but only if the Snap Isolate checkbox in the respective "child" Instrument's Function page
is disengaged (see section ↑6.4.8, Defining Snapshot Behavior for Instruments for more infor-
mation on this).

Shorter Morph Time values decrease the delay between changing the Morph slider position
and having the Panel controls complete their morphs. Longer Morph Time values increase
this delay.

Making a Control Immune to Morphing

You can specify which Panel controls should not be affected by “morph” operations. To make
a control immune to Snapshot morphing, follow these instructions:

1. Double-click on the desired control like a knob, fader, list, or button.
2. This should have opened up the control's Properties View. Now click on the Function but-

ton.

3. Engage the Mrph./Rnd Isolate checkbox in the Snapshots area of the control's Function
page. Now the Morph slider will have no effect on that control.

To see how to assign a MIDI controller to the Morph function, please refer to the Applica-
tion Reference.

What's New in REAKTOR 5.6.2?

Snapshots

 

REAKTOR 5 - Manual Addendum - 105



6.4.6 Randomizing Snapshots
 

Probably the fastest way to create a new Snapshot is by using the Randomize or Random
Merge buttons. The Snapshot Randomize area in the Snapshot tab (see figure below) holds the
controls with which you can quickly create a new Snapshot with varying degrees of random de-
viation from the current Snapshot.

The Snapshot Randomize area in the Snapshot tab lets you create new Snapshots with varying degrees of random deviaton
from the current Snapshot.

Randomizing Snapshots

If you want to randomize all of the selected Instrument's Panel controls (except those with the
Random Isolate checkbox engaged, see below) follow these instructions:

1. Make sure you have an Instrument open.
2. Open the Snapshot tab and if the Snapshot Randomize area depicted above is not open,

press the arrow button next to the text "Snapshot Morphing and Random", shown below.

3. First, decide what maximum amount of random deviation from the Instrument's current
Panel controls you would like. Then enter the corresponding value into the Random
Amount edit field. The Random Amount edit field accepts values in the range [0 … 100].
“0” corresponds to 0 % and “100” corresponds to 100 % of the control's range. If we say
the value in the Random Amount field is “R” then pressing the Randomize button can
change the control's current setting up to ± R % of the control's range. For example, if a
knob with a range [-1 … 1] is set to its middle point “0” and the Random Amount edit
field is set to “25” (meaning 25 %), then clicking on the Randomize button can change
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the knob's value to anywhere from -0.5 to 0.5, that is, (0 ± 0.25 * 2). Note that a control
can never be randomized to a value beyond its range:

4. After having entered the desired value into the Random Amount edit field, click on the
Randomize button:

Random Merging of Two Snapshots

You can also use two existing Snapshots as seeds and randomly merge these two “parent”
Snapshots to create a “child” Snapshot. The resulting “child” Snapshot is a random combina-
tion of the two “parent” Snapshots with the amount of randomness being set with the Random
Amount edit field. To use this feature, you need to follow these instructions:

1. Make sure you have an Instrument open with at least two Snapshots.

2. Open the Snapshot tab and if the Snapshot Randomize area depicted above is not open,
press the arrow button next to the text "Snapshot Morphing and Random", shown below.

3. You need to choose the first “parent” Snapshot. For that, click on the Select A button to
activate it (its text should change to "Select…").

4. Then select the first of the two “parent” Snapshots (Snapshot A) from the Snapshot List.
5. Now click the Select B button to activate it (its text should change to "Select…").
6. Select the second of the two “parent” Snapshots (Snapshot B) from the Snapshot List.
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7. To decide, what value you want to enter into the Random Amount edit field, consider the
behavior of the “Random Merge” feature. The “Random Merge” operation is taken for
each Instrument Panel control separately. Let's look at one control and let the value in the
Random Amount edit field be denoted by the letter “R” (it is a value in the range [0 …
100]). For an R = 0, pressing the Random Merge button results in the control receiving a
new value that is exactly between the two values corresponding to the “parent” Snap-
shots. For R = 100, pressing the Random Merge button results in the control receiving
either the value of “parent” Snapshot A or “parent” Snapshot B. In general, if R > 0, then
pressing the Random Merge button causes the control randomly to be assigned to one of
the two parents and the value “R” decides how much the new value of the control devi-
ates from the perfect merge (arithmetic mean) of the two “parent” Snapshots in the direc-
tion of the assigned “parent” Snapshot. As mentioned above, for R = 100, the deviation
is complete, that is, the new control value is that of the assigned “parent” Snapshot. En-
ter the value corresponding to the desired randomness into the Random Amount edit
field.

8. Last, press the Random Merge button.

Making a Control Immune to Randomization

You can specify which Panel controls should not be affected by “randomize” operations. To
make a control immune to randomization, follow these instructions:

1. Double-click on the desired control like a knob, fader, list, or button.
2. This should have opened up the control's Properties View. Now click on the Function but-

ton.

3. Engage the Mrph./Rnd Isolate checkbox in the Snapshots area of the control's Function
page. Now the Randomize button will have no effect on that control. You can use this
technique in conjunction with the Random Amount value to limit the amount of randomi-
zation an Instrument's controls receive.

The Mrph./Rnd Isolate checkbox
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6.4.7 Snapshot Banks
 

Each and every Snapshot in REAKTOR belongs to a Snapshot Bank. You can save your Snap-
shots on your hard drive or any other medium and even share your Snapshots by saving the
Snapshots Bank to which those Snapshots belong to. In this section you will learn all about
Snapshot Banks in REAKTOR.

Saving, Loading, and Creating Snapshot Banks

This subsection will discuss the basic operations tied to Snapshot Banks.

Selecting Snapshot Banks

Some Instruments already come with several Snapshot Banks. To see which banks have al-
ready been loaded and to select a new bank, follow these instructions:

1. First, open an Instrument that has several Snapshot Banks already loaded. Space Drone is
a good example of one, you can find it in the factory library in under New Additions >
Sound Generators.

2. Open the Snapshot tab and look at the Snapshot Banks area shown in the figure below.

3. As you can see in the figure above, two banks have been loaded. Click on Bank 2 to load
the second Snapshot Bank into the Snapshot List.

Saving and Loading Snapshot Banks

To save a Snapshot Bank, follow these steps:

1. Make sure you have an Instrument open.
2. Open the Snapshot tab and look at the Snapshot Banks area shown in the figure below.
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3. To save the selected Snapshot Bank (see above), click on the Edit Bank drop-down menu
and choose the Save Bank menu entry. This will open a dialog box to choose where you
want to save the Snapshot Bank file. The Snapshot Bank file is saved as an *.ssf file.

4. To load a new Snapshot Bank into REAKTOR, choose the Load Bank menu entry from the
Edit Bank drop-down menu, as shown in the figure below. This will open a dialog box to
browse for the *.ssf Snapshot Bank file you wish to load.

5. After clicking on “OK” in the dialog box, the Snapshots contained in the Snapshot file
you just loaded are appended to the current Snapshot List. If the list is full, then a new
Snapshot Bank is created and the remaining Snapshots from the Snapshot file are loaded
into that new Bank.

6. Usually one creates a new Bank right away before loading the Snapshots that are in a file
into the Bank. This way the Snapshots in different Banks and Snapshot files don't get
mixed up. To create a new Bank, click on the Edit Bank drop-down menu and choose the
New Bank menu entry. This creates a new Snapshot Bank consisting of empty slots. You
can now either start creating and saving your own Snapshots with the Instrument (see
section ↑6.4.2, Adding and Removing Snapshots) or load the Snapshots from a Snapshot
Bank file into the Bank as shown in steps 4 and 5.
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To create a new Snapshot Bank, select the New Bank menu entry from the Edit Bank drop-down menu.

Cloning and Deleting Banks

This subsection describes how to clone (duplicate), init (clear all Snapshots), and delete Snap-
shot Banks.

Cloning Banks can be useful in many cases. Maybe you want to duplicate a factory Snapshot
Bank to create your own modifications to the Snapshots or perhaps you want to use the dupli-
cate Bank to pick out only Snapshots that have a certain flavor to them. This is how you clone
a Bank:

1. Make sure you have an Instrument open.
2. Open the Snapshot tab and click on the Edit Bank drop-down menu.
3. Click on the Clone Bank menu entry (see below). A new Snapshot Bank will be created

with its Snapshot List identical to the Bank that you cloned.
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4. To clear all Snapshots from the currently selected Bank and replace them with empty
slots, you need to click the Init Bank menu entry (see below).

5. This results in an empty Snapshot Bank (see figure below). And if you want to delete a
Snapshot Bank completely, choose the Delete Bank menu entry from the Edit Bank drop-
down menu. Note that you cannot delete a Snapshot Bank if it's the only one left for that
Instrument.

If you delete a Bank by mistake, don’t panic! Simply use REAKTOR's Undo Delete Snap
Bank menu entry in the Edit application menu to restore it.

Renumbering and Renaming Banks

Let's say you want to take a factory Snapshot Bank, remove the Snapshots you don’t like, and
rename the new Bank. In this subsection you will first learn how to get rid of the gaps in the
Bank that result from deleting Snapshots by using the “Renumber Bank” feature. Then you
will see how to rename your Bank. Perform the following steps:

1. Make sure you have an Instrument open.
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2. Now open the Snapshot tab and clone a Bank so that you don’t lose the Snapshots you
are about to delete in the cloned Bank (see subsection ↑6.4.7, Snapshot Banks on how to
clone Banks).

3. Next, delete some Snapshots from the cloned Snapshot Bank by selecting the Snapshot
Entry and then choosing the Delete Snapshot menu entry from the Edit Bank drop-down
menu. You can also use the [Del] key on your computer keyboard. The resulting Snapshot
List should look something like the one shown below.

→ Deleted Snapshots are replaced by Snapshot entries labeled <empty>:

Resorting the Snapshot List

Now resort the Snapshot List by shifting the Snapshots upwards so that there are no empty
slots between individual Snapshots:
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1. Click on the Edit Bank drop-down menu and select the Sort and Compress Snapshots
menu entry (see figure below).

2. The resulting Snapshot List should now look similar to the one shown below.

After selecting the Sort and Compress Snapshots menu entry from the Edit Bank drop-down menu all empty slots in the
Snapshots List are removed.
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Renaming a New Snapshot List

► To rename the Bank that is your new Snapshot List, type the new name into the Bank
Name edit field, as shown below.

6.4.8 Defining Snapshot Behavior for Instruments
 

In Ensembles consisting of several Instruments, Snapshots of one Instrument often go together
with particular Snapshots of another Instrument. Junatik is an example of such an Ensemble:
it consists of a synthesizer Instrument and a delay effect Instrument. Therefore it is often de-
sirable to recall or save the Snapshots for several Instruments simultaneously. You can also
specify other specifics regarding Snapshot behavior of Instruments. This section discusses all
things connected to an Instrument's behavior regarding Snapshots. The picture below shows
the Snapshot area of an Instrument's Function Tab where the properties of its Snapshot behav-
ior are set.

An Instrument's Snapshot behavior is determined by the settings in the Snapshot area of the Instrument's Function page.

Instruments Hierarchy

Any Instrument that contains another Instrument is called a "parent" Instrument. For example,
an Ensemble (top-level Instrument) that contains another Instrument is a "parent" Instrument.
A "child" Instrument is an Instrument that is contained within another ("parent") Instrument. It
is important to understand this hierarchy in order to properly control the Snapshot Behavior.
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The Snap Isolate Property

By default, Snapshots are stored and recalled by the "parent" Instrument (usually the Ensem-
ble). This means that you can store and recall Snapshots for multiple "child" Instruments at
the same time using the "parent" Snapshot. Sometimes this is just what you want. Other times,
you might want to store and recall Snapshots independently of the "parent" Instrument. This is
done using the Snap Isolate property, as shown by the instruction steps below.

1. Open or create an Ensemble containing two Instruments, each with its own populated
Snapshot List.

2. Go to the Function page of both "child" Instruments and make sure that the Snap Isolate
checkbox is disengaged, as shown in the figure below. This means that Snapshot recall,
store, and morph operations done on the Ensemble will effect the "child" Instruments.
Let's see what this means.

3. First change the state of the controls of the "child" Instruments by recalling some other
Instrument Snapshots.

4. Now, store a new Snapshot for the Ensemble ("parent" Instrument). Please refer to section
↑6.4.2, Adding and Removing Snapshots if you don't know how to do this. Take note of
which Instrument Snapshots are loaded during the storing process.

5. Again, change the state of the controls of the "child" Instruments by recalling some other
Instrument Snapshots.

6. Next, recall the Ensemble Snapshot you stored last. Notice how the "child" Instruments
automatically recalled the Snapshots that were loaded at the time when you saved the
"parent" Snapshot.

7. What happens if we modify Instrument Snapshots and then store the Ensemble Snapshot?
To see this, load some Instrument Snapshots and modify the Panel controls. Note that an
asterisk appears in the Snapshot drop-down menu in the Instrument header when a Snap-
shot has been modified. This is shown in the figure below.

8. Append another Ensemble ("parent" Instrument) Snapshot.
9. Modify the Instrument controls
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10. Recall the Ensemble Snapshot you just saved. Notice how not only the Instrument Snap-
shots were recalled, but also the modifications that you did to the Instrument controls.
Because the Instrument controls have been modified from their Snapshot values by the
Ensemble Snapshot, the asterisk again appears in the Instrument header, as shown
above.

11. Now, let's see what happens if the Snap Isolate checkbox is engaged. Go to the Function
pages of the "child" Instruments and engage the Snap Isolate checkbox, as shown in the
figure below.

12. Now append yet another Ensemble Snapshot.
13. Now change the state of the controls of the "child" Instruments by recalling some other

Instrument Snapshots.
14. Next, recall the Ensemble Snapshot you just stored. Notice how the Instrument's controls

or the Instrument Snapshots remain unchanged upon the Ensemble Snapshot recall. This
is exactly what the effect of engaging the Snap Isolate checkbox is.

In summary, when you recall the Snapshot of a “parent” Instrument, the Snapshots of all
"child" Instruments which have the Snap Isolate checkbox in their Function page disengaged,
will also be recalled. Similarly, saving a new Snapshot for the “parent” Instrument saves the
Snapshots of its "child" Instruments which have the Snap Isolate checkbox disengaged. Note
that recalling a "parent" Instrument Snapshot not only recalls the "child" Instrument's Snap-
shot that was loaded at the time of storing the "parent" Snapshot, but also sets the "child" In-
strument's controls to the state in which the "parent" Snapshot was stored.

Generally you can have an Ensemble containing both Snap Isolated and non-Snap Isolated
"child" Instruments.

The "parent" Instrument must not necessarily be the Ensemble. It can be any Instrument that
contains another Instrument. If a non-Snap Isolated Instrument contains another non-Snap
Isolated Instrument, then changing the Ensemble Snapshot will affect the "child" Instruments
all the way down to the lowest level of the Instrument hierarchy.
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The Snapshot Master

The Snapshot Master feature is particularly relevant when running REAKTOR as a plug-in.
When this feature is activated for an Instrument or Ensemble, the Snapshots List of that In-
strument is forwarded to the host. It also appears in the Snapshot menu in the Main Toolbar.
However, since most hosts can handle only one Snapshots List, this feature can be enabled for
only one Instrument (or the Ensemble). This is done using the Set As Master button, as shown
by the instruction steps below.

1. Make sure you have an Ensemble with two active Instruments open.
2. First you need to choose which Instrument is the Snapshot Master for your Ensemble. By

default, the Snapshot Master is the Ensemble. To set an Instrument to be the Snapshot
Master Instrument, go to the Function page of the Instrument Properties, as shown below.

3. Then engage the Set As Master button. When the Set As Master button is engaged, the
Instrument's Snapshots are available in the host program and appear in the Snapshot
menu in the Main Toolbar. Note that an icon appears in the Snapshot drop-down menu in
the Instrument header to show it is now the Snapshot Master.

Recalling Snapshots by MIDI

Each Snapshot Bank can hold 128 Snapshots. This number is not arbitrary; it has been chos-
en to provide optimal compatibility when recalling Snapshots via MIDI Program Change mes-
sages. To enable the Recall by MIDI option, engage the Recall by MIDI checkbox in the Instru-
ment's Function page.

The Recall by MIDI checkbox

When the Recall by MIDI checkbox has been engaged, an incoming MIDI Program Change
message with the value “N” (where “N” is an integer in the range [0…127]) will recall the
Snapshot with the number “N + 1” (if that Snapshot exists). Thus a Program Change message
of “0” will recall Snapshot “1”, a message of “1” will recall Snapshot “2”, and so on. This
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way you can quickly and easily recall Snapshots from your MIDI device by issuing MIDI Pro-
gram Change messages for the desired Snapshot number. If the “parent” Instrument also has
this feature enabled and is on the same MIDI channel as another “child” Instrument, then the
“parent” Instrument's Snapshot will take precedence. Please refer to subsection 13.2.1 in the
Application Reference to learn how to change the incoming MIDI channel number for an In-
strument.

6.4.9 Opening and Saving Presets
 

REAKTOR 5.6.2 allows you to quickly save and recall the complete state of an existing Ensem-
ble using the new Preset file. The extension of the REAKTOR Preset file is *.nrkt.

Saving a Preset File

To save a Preset file, follow these instructions:

1. Open the Ensemble for which you wish to save a Preset.
2. If your Ensemble contains "child" Instruments for which you wish the Preset file to save

the control settings, make sure that the Snap Isolate checkbox in the respective Instru-
ment's Function page is disengaged (see section ↑6.4.8, Defining Snapshot Behavior for
Instruments for more information on this).

3. Press the Menu button and choose the File > Save Preset As… menu entry (shown in the
figure below).
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Use the File > Save Preset As… menu entry to save a Preset file.

Note that the Preset file does not contain the Ensemble itself. It merely stores the Ensemble
location. Therefore, if you modify the Ensemble or change the Ensemble's location you will not
be able to recall the Preset!

Loading a Preset File

To load a Preset file, follow these instructions:

► Press the Menu button and choose the File > Open Preset menu entry (shown in the fig-
ure below).
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Use the File > Open Preset menu entry to load a Preset file.

Note that the Preset file does not contain the Ensemble itself. It merely stores the Ensemble
location. Therefore, if you modify the Ensemble or change the Ensemble's location you will not
be able to recall the Preset!

If you are already familiar with the REAKTOR 5.5 Snapshot behavior and are just interest-
ed in the changes, you may use the cross-reference link to proceed on to section ↑6.4.8,
Defining Snapshot Behavior for Instruments.
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7 Keyboard Shortcuts

 

7.1 Changed Keyboard Shortcuts
 

In REAKTOR 5.6.2, the following keyboard shortcuts have changed:

▪ Toggle Edit mode: [F1]

▪ Toggle Horizontal Split Pane: [F2]

▪ Toggle Vertical Split Pane: [F3]

▪ Toggle Properties View: [F4]

7.2 New keyboard Shortcuts
 

In REAKTOR 5.7, the following keyboard shortcuts have been added:

▪ Close a Pane or Screenset: [Ctrl] + [F4] ([Cmd] + [W] on Mac)

▪ Create a new Screenset: [Ctrl] + [T] ([Cmd] + [T] on Mac)

▪ Switch to next Screenset: [Ctrl] + [Tab]

▪ Switch to previous Screenset: [Ctrl] + [Shift] + [Tab]

▪ Select Screenset: [Ctrl] + [Alt] + [1…8] ([Ctrl] + [Cmd] + [1…8] on Mac)

▪ Enable/Disable Wire Debugging: [Ctrl] + [B] ( [Cmd] + [B] on Mac)

In REAKTOR 5.6.2, the following keyboard shortcuts have been added:

▪ Scrolling of the Structure: [Alt] + Drag

▪ Navigate the the previous Structure: [Alt] +[B]

▪ Show the contents of a Macro in the other Split Pane: [Alt] + double-click Macro

▪ Open the Searchbox: [Enter]/[Return] or [Ctrl] +[F] in Windows ([Cmd] +[F] in Mac OS X)

▪ Navigate to the parent folder in the Browser's folder tree: Left Arrow
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▪ Delete Objects and Wires: [Backspace] or [Delete]

▪ Duplicate Objects: [Ctrl] + drag Object ([Alt] + drag on Mac OS X)

▪ Copy Objects to the other Split Pane: [Ctrl] + drag ([Alt] + drag on OS X)

▪ Breadcrumb Navigation, down: [Alt] + [Right]

▪ Breadcrumb Navigation, up: [Alt] + [Left]
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8 Keyboard Shortcut Overview

 

APPLICATION Action Mac OS X Windows

    

 Show module search box [Enter], [Cmd] + [F] [Enter], [Ctrl] + [F]

    

 Preset change (when an instrument is
selected)

[Up], [Down] [Up], [Down]

    

 View Info [Cmd] + [I] [Ctrl] + [I]

    

 Toggle MIDI & OSC Learn [Cmd] + [M] [Ctrl] + [M]

    

 Toggle Audio [Cmd] + [R] [Ctrl] + [R]

    

 Start Clock [Space] [Space]

    

 Reset Clock [Cmd] + [Space] [Ctrl] + [Space]

    

 Preferences [Cmd] + [,] [Ctrl] + [,]

    

 Quit [Cmd] + [Q] [Alt] + [F4]

    

FILE Action Mac OS X Windows

    

 New [Cmd] + [N] [Ctrl] + [N]
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 Open… [Cmd] + [O] [Ctrl] + [O]

    

 Save [Cmd] + [S] [Ctrl] + [S]

    

 Save As… [Cmd] + [Shift] + [S] [Ctrl] + [Shift] + [S]

    

EDIT Action Mac OS X Windows

    

 Undo [Cmd] + [Z] [Ctrl] + [Z]

    

 Redo [Cmd] + [Y] [Ctrl] + [Y]

    

 Select All in Structure [Cmd] + [A] [Ctrl] + [A]

    

 Marquee Select Click and drag around a
group

Click and drag around
a group

    

 Add To or Remove From Selection [Cmd] + Click [Ctrl] + Click

    

 Cut [Cmd] + [X] [Ctrl] + [X]

    

 Copy [Cmd] + [C] [Ctrl] + [C]

    

 Paste [Cmd] + [V] [Ctrl] + [V]

    

 Duplicate [Cmd] + [D] [Ctrl] + [D]

    

 Duplicate (In Structure) [Alt] + drag Module [Ctrl] + drag Module
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 Delete [Delete] [Backspace], [Delete]

    

SNAPSHOT Action Mac OS X Windows

    

 Next Master Snapshot [Cmd] + [Down] [Ctrl] + [Down]

    

 Prior Master Snapshot [Cmd] + [Up] [Ctrl] + [Up]

    

PANEL Action Mac OS X Windows

    

 Toggle Panel Edit [Cmd] + [P] [Ctrl] + [P]

    

 Save Panelset 1…8 [Cmd] + [Shift] + [1…
8]

[Ctrl] + [Shift] + [1…8]

    

VIEW Action Mac OS X Windows

    

 Append Screenset [Cmd] + [T] [Ctrl] + [T]

    

 Recall Screenset 1…8 [Cmd] + [1…8] [Ctrl] + [1…8]

    

 Next Screenset [Ctrl] + [Tab] [Ctrl] + [Tab]

    

 Previous Screenset [Ctrl] + [Shift] + [Tab] [Ctrl] + [Shift] + [Tab]

    

 Edit Mode [F1] [F1]
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 Forward in Bread Crumbs (Structure
View)

[Alt] + [Right] [Alt] + [Right]

    

 Backward in Bread Crumbs (Structure
View)

[Alt] + [Left] [Alt] + [Left]

    

 Toggle Horizontal View Button [F2] [F2]

    

 Toggle Vertical View Button [F3] [F3]

    

 Switch Between Horizontal and Verti-
al View (Structure View)

[Ctrl] + [H] [Ctrl] + [H]

    

 Close Pane / Screenset [Cmd] + [W] [Ctrl] + [F4]

    

 Scroll [Alt] + drag background [Alt] + drag back-
ground

    

 Toggle Properties [F4] [F4]

    

 Toggle Browser [F5] [F5]

    

 Toggle Snapshots [F6] [F6]

    

 Toggle Panelsets [F7] [F7]

    

 Toggle Sample Map Editor [F9] [F9]

    

 Toggle Input & Recorder Bar [F10] [F10]
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 Full Screen Mode [F11] [F11]

    

 Show Structure in Other Pane [Alt] + Double-click [Alt] + Double-click

    

 Back / Previous structure [Alt] + [B] [Alt] + [B]

    

DEBUG STRUCTURE Action Mac OS X Windows

    

 Enable Wire Debugging [Cmd] + [B] [Ctrl] + [B]

    

 Measure CPU Usage [Cmd] + [U] [Ctrl] + [U]

    

 Toggle relative/absolute CPU usage
(when measure CPU usage option is
active)

[Cmd] + Click in pri-
mary structure back-
ground

[Ctrl] + Click primary
structure background

    

 Show Module Sorting [Cmd] + [Alt] + [A] [Ctrl] + [Alt] + [A]

    

 Show Event Init Order [Cmd] + [Alt] + [E] [Ctrl] + [Alt] + [E]
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